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Installing Session Software
(Demo Version)

Introduction

Welcome to Digidesign Session™ Software. Session Software gives you the power to produce,
record, edit, mix, and master professional-quality digital recordings in a single easy-to-use
software application.

The demo version of Session Software contained on this CD-ROM provides virtually all of the
functionality of the full version of Session Software, with two important exceptions: you cannot
save sessions, and the Session application will automatically quit after 15 minutes of use. If you
like what you see, and wish to purchase the retail version of Session, please contact Digidesign
at 800-333-2137 for the name of your local Digidesign dealer.

This brief User’s Guide is designed to help you install the Demo Version of Session Software
and teach you some of the essentials of creative audio production with Session. Using the included
Adobe™ Acrobat™ Reader software you can read this User’s Guide on screen, or print it out using a
Macintosh-compatible printer.

Session Software provides:

= 2-channel input and output
= 2 tracks of digital audio recording
= 4-16 tracks of digital audio playback. Track performance varies with computer speed,
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hard drive speed, and amount of RAM. In general, you can expect the following perfor-
mance from these systems:

= Macintosh with a Digidesign Audiomedia I1™ card: 4 tracks of playback
= 60 MHz or faster Power Macintosh: 8 tracks of playback

« 80 MHz or faster Power Macintosh: 12 tracks of playback
« 100 MHz or faster Power Macintosh: 16 tracks of playback
< Nonlinear, random-access editing
= Mix automation with independent control of volume and pan
= Synchronized MIDI sequencer playback via OMS™ (retail version only)

= Support for a wide variety of audio file formats including Sound Designer I, AIFF,
QuickTime, WAYV and SND.

Session Software is ideal for a variety of uses. If you are a musician, Session allows you to go
from initial concept to completed project digitally, with exceptional control over every step of
the creative process. You can record, arrange and edit your material quickly and easily, trying
out any number of creative ideas, and finally, perform an automated mixdown to create a fully
digital stereo master recording with EQ.

If you are creating audio for multimedia, Session is a powerful tool for soundtrack production.
Session allows you to import QuickTime movies and synchronize or “spot” music, audio, dialog and
effects. Completed soundtracks can be exported to a QuickTime movie, converted to 8-bit resolution
at a variety of sample rates, and saved in a number of popular formats including QuickTime, WAV,
AIFF, SND and Sound Designer Il. Thanks to Session, every step in the multitrack production of
digital audio is now available in a uncompromisingly powerful software package that is affordable
to everyone.



System Requirements
= Power Macintosh, Quadra-series, or Mac llci computer. Quadra-series or Macintosh(lci
computers require Digidesign’s Audiomedia Il card.
= 13” or larger color monitor.
e 16 Mb RAM minimum. Additional RAM will increase performance.
= Apple System 7.1 or greater (7.1.2 is required for Power Macs).
= QuickTime™ 2.0 or greater.
= A hard drive with a sustained transfer rate of 2.5 megabytes per second or faster.
= Version 3.1 or greater of the Apple Sound Manager. (Included on your Installer disks.)

Maximizing System Performance

Session Software is both powerful and power-hungry. To get the best performance out of your
software and your Macintosh, there are several things you can do.

To maximize performance:
= |f you have a Power Macintosh, use the Power PC Size pop-up (part of the Change Play-
back Hardware dialog) to set the number of tracks in your session no larger than you

absolutely need. The greater the number of tracks you choose, the greater the demand on
your computer. You can always increase the number of tracks later in a session.

11



= Run as clean a System as possible, using a minimal number of System Extensions.

= Turn off any System Extensions that are in constant operation such as menu bar clocks,
screen savers, etc.

* Turn off File Sharing.
= Disconnect your Macintosh from any networks and turn off AppleTalk.

= Allocate additional RAM to Session Software if necessary, using the Finder’s Get Info
command.

* Optimize your hard drive.

= |f you’re working with QuickTime movies in your session, view the movie at its smallest
size.
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Making Audio Connections to a Mixer

For optimum flexibility and fidelity we recommend that you use a good quality mixer with
Session Software. Audio connections between a mixer and your Macintosh are simple to set up.
They differ slightly depending on whether you are using an Audiomedia Il card or the built-in
sound input/output connectors on a Power Macintosh. Instructions are given for each case
below.

Using a Power Macintosh
If you own a Power Macintosh, you will use its built-in audio input and output connectors to
bring audio into and out of your system. Make connections as follows:



To make audio connections to a Power Mac’s built-in audio connectors:

= Connect your Power Mac’s audio output to your mixer’s input. The Power Mac’s audio

output jack is a standard stereo mini-plug connector. Most mixer inputs require a 1/4
inch phone jack or an RCA jack. To make this connection, use a mini-plug to 1/4 inch or

mini-plug to RCA adapter, depending on your mixer.

= Connect your mixer’s output to the Power Mac’s audio input connector. The Power
Mac’s audio input jack is a standard mini-plug connector. Most mixer outputs are 1/4

inch phone connectors or RCA connectors. To make this connection, use a 1/4 inch to mini-

plug or RCA to mini-plug adapter, depending on your mixer.

back of Power Macintosh

microphone

audio
input

audio
output

miniplug to
female RCA cable

RCA-to-1/4 inch
adapter cables.
Attach to mixer outputs

power amp and speakers

©
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©

o]

'Y

left
output

right
output

0000000

Making audio input connections to a Power Macintosh
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If You Are Using a Digidesign Audiomedia Il Card
If you own a Digidesign Audiomedia Il card, you can use its high-fidelity audio input and
output connectors to bring audio into and out of your system. Make connections as follows:

To make audio connections to an Audiomedia Il-equipped Macintosh:

= Connect your Audiomedia Il card’s analog audio outputs to your mixer’s inputs. The
Audiomedia Il card’s analog audio output jacks are standard RCA connectors. Most
mixer inputs require a 1/4 inch phone jack or an RCA jack. To make this connection, use
RCA to 1/4 inch adapters, or standard RCA cables depending on your mixer.

= Connect your mixer’s outputs to the Audiomedia Il card’s analog audio input connec-
tors. The Audiomedia Il card’s analog audio inputs are standard RCA connectors. Most
mixer outputs are 174 inch phone jacks (or sometimes, RCA jacks). To make this connec-
tion, use 1/4 inch to RCA adapters, or standard RCA cables depending on your mixer.

power amp and speakers

microphone

©
:’olr:nii digital input/output

/ ,\* (connect to DAT inputs/outputs) left right
o output output
o e g it P P

I[ 2 R onnect to mixer outputs,

boocooooo

log outp

analog output
< 3 (connect to mixer inputs)
)
5 D
RCA-to-1/4 inch
adapter cables
mixer

RCA-to-1/4 inch
adapter cables

Making audio connections to an Audiomedia ll-equipped Macintosh



Installing Session Software

Session Software comes with an auto-installer, making installation fast and easy. Because Ses-
sion is a “fat binary” application, it will work on either Power Macintosh or non-Power Mac
models. In order to run properly, the Session application requires the following:

= Apple System 7.1 or later must be running on your Mac (System 7.1.2 is required for
Power Macs.)

= Virtual Memory must be off. Open the Control Panels folder within your System folder,
double-click the item called Memory, and click the Off button next to Virtual Memory.
Session will not run unless Virtual memory is off. After you do this, restart your com-
puter.

= |f you have a Quadra-series Macintosh, 32-bit Addressing must be turned on. Open the
Control Panels folder within your System folder, double-click the item called Memory, and
click the On button under 32-bit Addressing. After you do this, restart your computer.

If You Own a Quadra 900 or 950

If you wish to run Session on a Macintosh Quadra 900 or Quadra 950, you need to use Apple’s
Serial Switch software. The Serial Switch is a Control Panel device that goes in the Control Panels
folder inside your System folder. It allows you to set these Macintosh models to run in “faster”
mode or in “compatible” mode. Session requires that these models of Macintosh be set to com-
patible mode. The Serial Switch software is included on your Session diskettes. To install it, drag
it from the CD-ROM to your closed System Folder. Then open the Control Panels folder (within
the System folder) and double-click the item called Serial Switch. When it opens, set it to compat-
ible and restart your Macintosh. Remember, use the Serial Switch software only if you have a
Quadra 900 or Quadra 950.

15
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To Install Session Software:

= |f you are using any virus-protection software, turn it off or temporarily remove it and
restart your Macintosh.

= Insert the Session Software Demo CD-ROM in your CD-ROM drive and double-click the
Session Installer. The Installer opens and this dialog appears:

session Installer =—————PI5

[ Easy Install |

IT necessary, click “Switch Disk™ to choose a destination hard
drive. Then, click “Install” to place Session on that drive, and to
install DAE and DigiSystem INIT.

—Destination Disk

Eject Disk
— . .
Internal Drive Switch Disk I Install I

@]

The Installer dialog

= Select the drive on which you’d like to install the Session application. Select your Startup
drive (the drive that has your System Folder on it).

= |f you wish to install everything from your Session disks, choose Easy Install from the
pop-up at the top of this dialog.

= Alternatively, if you wish to select individual items for installation, choose Custom Install
from the pop-up, select the desired items, and click Install. (Digidesign recommends that
you choose the Easy Install option and install everything. Don’t choose Custom Install



unless you know exactly what you are doing—if you skip any essential items, your sys-
tem may not function correctly.)

= After you have clicked Install, follow the on-screen instructions. The Installer will install
Session Software in a folder named Digidesign on your hard disk.

= When the installation is complete, a message will appear indicating that the installation
was successful. Click OK to restart your Macintosh. (After restarting, don’t forget to turn
back on any virus-protection software that you may be using.)

Installing the Demo Sessions

The Session Software Demo CD-ROM includes several sample sessions that illustrate the many
uses of Session software. These sessions range in size from 7 Megabytes to 110 megabytes in
size. Slower Macintoshes/hard drives may not be able to play the Demo Sessions which feature
more than 8 tracks.

The included Sessions are:

= “Demo Session 17 4 tracks, 7.5Mb. This a very short, simple music demo.

* “Multimedia Demo” 4 tracks, 36Mb, with a QuickTime™ movie. This session mixes music,
narration, and a QuickTime movie to showcase Session’s multimedia production capa-
bilities.

= “Lemonhead Promo” 8 tracks, 25Mb. This is a radio commercial spot illustrating how
Session can be used for radio/broadcast production.

= “Don’t Stop” 12 tracks, 110Mb. This demonstrates Session used for commercial music
demo production.

« “Nike” 15 tracks, 39 Mb, with a QuickTime™ movie. This session showcases Session’s
audio post production capabilities in the context of a major television commercial.

17



= If you wish, copy one or more of the Demo Sessions to your hard drive.

To Install a Demo Session:

= Double click the Folder called Demo Sessions. Within this folder you will see several more
folders, each of which contains a different demo.

= Locate the folder that contains the demo session you want and drag it to your hard drive.

Once you have copied the desired Demo Session(s) to your hard drive you will be able to open
and play them with Session Software. Do not try to play a demo Session from the CD-ROM! CD-
ROM drives are much too slow to do this. A session must be copied to your hard drive if you
wish to play it.

18

Starting Session Software for the First Time and Configuring Your System

The first time you open Session Software, the Hardware Setup dialog appears prompting you to
configure your system according to your computer setup.

You have three options for configuring Session Software:

= If you have a Power Mac: You can run Session Software without any additional
Digidesign hardware. Session Software will provide stereo recording and from 8-16
tracks of audio playback depending on your Power Mac’s processor speed and the speed
of your hard drive. This scenario provides the greatest number of tracks, but relies on the
Power Mac’s built-in 16-bit audio converters for input and output. These built-in convert-
ers provide lower fidelity than those found on Digidesign cards such as Audiomedia Il.



= If you have a non-Power Mac with a Digidesign Audiomedia Il card: You can
run Session Software using the DSP power of the Audiomedia Il card. Session Software
will provide stereo recording and 4 tracks of audio playback. This scenario provides
fewer tracks than a Power Mac, but offers greater fidelity input and output due to the
superior quality of the 16-bit audio converters on Digidesign’s DSP cards.

= If you have a Power Mac AND a Digidesign Audiomedia Il card: Since Session
Software allows you to switch between the Audiomedia card and the Power Mac using
the Change Playback Hardware Command (Setups menu) this arrangement gives you the
best of both worlds: the high-fidelity input/output of the Audiomedia Il card and the
Power Mac’s 8-16 track capability. You can use Audiomedia II's high-fidelity input and
output to record your tracks; switch to the Power Mac hardware to edit, mix, and bounce
(with more tracks); and finally, switch back to Audiomedia Il if you wish to record your
master stereo mixdown on an external mastering recorder such as a DAT deck.

Configuring Session for a Power Macintosh
To start Session Software:

= Double-click on the installed Session application. The following dialog appears:

19



Hardware Setup
r Select Card Type: r Interface Options:
) Audiomedia™
® PowerPC™
~PowerPC Size:
4 Channels
8 Channels Recalibrate Inputs
12 Channels

The Hardware Setup dialog

= |f you have a Power Macintosh, click the Power PC button at the top of the Hardware
Setup dialog.

= Next, click the Power PC Size pop-up at the bottom of this dialog to select the default
number of tracks you wish to have in your session. (This will become the default setting
for all subsequent sessions until you change it again here.) The greater the number of
tracks you choose, the greater the demand on your computer’s performance. To maxi-
mize performance, set your session no larger than you absolutely need. You can always
increase the number of tracks later in the session with the Power PC Size pop-up.

= Click OK to close this dialog.

= To configure the Power Mac’s built-in 16-bit input and output capabilities, go to the
Finder and open the Sound Control Panel.

20



= When the Sound Manager appears, choose Sound In from the pop-up menu at the top of

this window.
5] Sound
Al Siedy
S Bal
linlumes
L 1.4
Simple Beep
S0 ypm
Spreeel
=5 W Eep
Mot Uolume | Sed... | | Rt |

The “Sound” Control Panel lets you configure
Sound Manager Input and Outputs

= In the Sound In window, click the Options button.

=]

Sound

| Sl |

Ewii-in

Choose & source Ter recording:

e,

Click the Options button to choose a sound input source
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= Select Microphone and then select Playthrough. This selects the sound input jack on the rear of
the Power Mac. Click OK when you are finished.

Input Source:

FMicrophone &Y Connector Internal CLr

W

) o o
(< Playthrough

Choosing a sound input source

= Next, choose Sound Out from the pop-up menu at the top of the Sound Manager window.

SO0=————— Sound

----- [ Sound 0ut v |

Choose a device for playback:

Bo

Euilt-in

Rate:| 44.100 kHz »

Size: (O 8 bit (@ 16 bit

&>

gl

Use: O MMono (8 Stereo

Choosing sound output options



= In the Sound Out window, select the sample rate that you desire (“Rate”). 44.1 kHz is the
Compact Disc standard. (This doesn’t affect Session, just audio playback through the Sound
Output jack on the Power Mac.)

= Select the bit resolution (*“Size). 16-bit is the Compact Disc standard. (This doesn’t affect
Session, just audio playback through the Sound Output jack on the Power Mac.)

= Select mono or stereo format (“Use”). We recommend stereo.
= Close the Sound window when you have finished and go back to the Session application.

Configuring Session for a Digidesign Audiomedia Il card:

= If you have an Audiomedia card installed in your computer and wish to use its 16-
bitlihputl@nd output capabilities (instead of a Power Mac’s built-in capabilities), choose
Audiomedia in the Select Card Type section of the Hardware Setup dialog.

Hardware Setup

- Select Card Type:
@ Audiomedia™

) PowerPC™ Sample Rate: 44100 w
S e
Ch1-2 Input:

r Interface Dptions:

~Cards To Use:

Recalibrate Inputs

The Hardware Setup dialog
(configured for an Audiomedia Il card) 23



= Next, choose an appropriate sample rate for your session. 44.1 kHz is the Compact Disc
standard. This will become the default setting for all subsequent sessions until you
change it again here.

= Under Ch 1-2 Input, choose the appropriate input format for your session. If you are
recording from an analog source such as an analog mixer, choose analog. If you are re-
cording from a digital source such as a DAT deck, choose digital.

= Click OK to close this dialog. You’re now ready to use Session Software.

IMPORTANT
If you ever wish to switch your Hardware Setup from a Power Mac’s built-in audio capabilities to
an Audiomedia II card or vice-versa, use the Change Playback Hardware command in the Setups
menu. This command will prompt you to save the current session before it allows you to change
your Hardware Setup from a Power Mac’s built-in audio capabilities to an Audiomedia II card or vice-
versa.

Making Sure Your System Is Working Properly

After you have installed Session Software, take a moment to make sure that your system is
working properly. To do this, copy Demo Session 1 from the CD-ROM drive to your hard drive.
Make sure your system is connected to your mixer and that your amplifier and speakers are
working so that you can hear Session’s audio output and listen to the Demo Session.

To get ready to test your Session system:
= Make sure any external SCSI hard drives that are connected to your computer are turned

on and running. When you use your Session system, you should always turn on any
external drives first, before you start your Macintosh.

24



= On the CD-ROM, double-click the Folder called Demo Sessions. When this folder opens,
drag the folder named Demo Session 1 to your hard drive.

= Open the Demo Session 1 folder that you have copied to your hard drive and double-click

on the file called Music Demo Session.

= Session will open and a dialog will appear, prompting you to locate the files needed for

the Music Demo Session.
= Locate and open the Music Demo Session folder, then select the folder called Audio Files.
= Click on the button at the bottom of the dialog that saysOpen if in “Audio Files.”

e by Macetgsh HD:Orums

EE=iv) = it e

[ Audio Fles |I|
7] Faalle Files

[ Camtal |

| S |

[ Npen 18 I Sge Files” ]
[ Search |= “infernal Orve” ]

The Where is? dialog

= Session will find the files it needs and the Demo will open.
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The Demo Session
To play the Demo Session:

= Adjust the volume control on your power amp or mixer so that it is set relatively low.
You can turn it up as the Music Demo begins to play.

= Press the Space bar on your Mac’s keyboard. You should hear the Music Demo begin to
play. If you wish to stop playback, press the Space bar again.

= To listen to the demo again, press the Space bar.

Welcome to Session Software!

If for some reason you weren’t able to play and hear the Music Demo Session, you may have
skipped a step in your installation. To find the problem, refer to the Troubleshooting section that
follows.



Troubleshooting

If you’re having trouble getting your system to work properly, the following checklist may help.

If Session won't start:

= Is Virtual Memory turned off? If not, open the Control Panels folder (in your System
Folder), double-click the item called Memory, and turn off Virtual Memory. Then restart
your computer.

= If you have a Quadra-series computer, is it running in 32-bit mode? If not, open the
Control Panels folder (in your System Folder), double-click the item called Memory, and
set it to 32-bit mode. Then restart your computer.

= Does your Macintosh have enough RAM (random-access memory)? Session requires that
you have at least 16 megabytes of RAM in your Mac in order to run. To find out how
much memory your computer has, choose About this Macintosh in the Finder’s Apple
menu. A window will appear telling you how much memory is currently installed in
your Mac.

= |s DAE installed in the DAE Folder inside your System Folder (on your Startup drive)? If
not, use your Session Installer disks to install it.

= |s the DigiSystem INIT installed in the Extensions folder (inside your System Folder)? If
not, use your Installer disks to install it.

= |s the SessionMix INIT installed in the DAE Extensions folder (inside the DAE Folder)? If
not, use your Installer disks to install it.

= Try a complete restart (turn off your computer peripherals and your Macintosh, and then
turn them on again).

27



About the Digidesign Audio Engine (DAE)

When you start Session you will notice that an application called DAE automatically launches in
the background. DAE stands for the Digidesign Audio Engine. It is Digidesign’s real time operat-
ing system for its digital recording systems. When you install Session, DAE is automatically
installed inside your System folder in a folder called DAE Folder.

Even though you can switch to DAE in the Finder menu, there is no need for you to do this, and
you shouldn’t attempt to quit DAE when you are running Session. When you quit Session, DAE
will automatically quit. You should never have to run or quit DAE by itself.

In the same way that the Macintosh System software provides the foundation for Macintosh
software applications, DAE provides the core functionality of hard disk recording, digital signal
processing, mix automation, and MIDI required by Session and other Digidesign products.
Because DAE is an application itself, separate from Session, it supplies these same capabilities to
products such as Studio Vision™, Logic Audio™, Digital Performer™, and Cubase Audio™ which
utilize DAE resources to record and play digital audio.

28

This concludes your installation of Session Software. Your system is now ready to use. To learn
some of the essentials of Session, navigate to the portions of this User’s Guide that follow. There
you’ll learn some of the fundamentals of using Session.



A Quick Visual Guide to the Session Software Interface

Take a moment to meet the Session Interface. It contains many buttons, sliders, and readouts
that allow you to record, edit, and mix digital audio.

Session has four windows:

= The Mix window, for setting levels and mixing

= The Edit window, for digital editing

= The Transport, for starting and stopping playback and recording
= The Movie window for importing and viewing QuickTime movies

Here’s what each of these windows looks like:

The Mix Window

To open the Mix window, select Mix from the Windows menu, or press Command-M on your
computer keyboard. The Mix window contains the controls of a fully-digital mixing console.
You will use this window to record tracks and adjust monitor and mixdown levels and equaliza-
tion. Each of Session’s tracks has its own controls for level, panning, record-enable, automation-
enable, EQ, and solo/mute.

29
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The Edit Window

To open the Edit window, select Edit from the Windows menu, or press Command-E on the
keyboard. The Edit window contains all of Session’s digital editing functions. Here, you’ll be
able to arrange and rearrange your music in ways that would be virtually impossible with tape.
The horizontal rows are tracks. The waveforms you see in the illustration represent audio on the
tracks. You can view other tracks in your session by adjusting the track view and scrolling as
necessary. With the editing tools in this window, tracks can be divided into pieces or regions and
rearranged in a different order. The column at the right of the screen is called the Audio Regions
List. It is a holding area for any regions that you create. From here, regions can be dragged into a
track and arranged as you wish.



The Transport
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To show the Transport window, select Transport from the Windows menu, or type Command-T
on the keyboard. The Transport window contains controls for (in order) Return to Zero, Rewind,
Stop, Play, Fast Forward, Record, and Loop Playback. The Transport also contains controls for
creating Markers, which allow you to quickly navigate to a desired point in a recording. The
Marker controls can be displayed or hidden by clicking the grow box at the upper right corner of

the Transport.

The Transport without Markers displayed
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The Transport with Markers displayed
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The Markers pop-up menu

The Movie Window

Session allows you to import QuickTime movies into your Session to create or edit soundtracks
for them. To display the Movie window (Command-Shift-M), you must first import a
QuickTime movie into your Session with the Import Movie command in the Movie menu. You
can display the Movie window at three possible sizes: half size, normal size, or double size.
Working with larger movie windows uses more processing power, so to maximize Session
performance, you may wish to display the Movie window at half size.



TATER FILMS INC.

The Movie Window

Mix Window Controls

Audio Record-Enable Button

Clicking this button arms a track for audio recording. To begin recording audio, click the audio
record-enable button, and then click the Transport’s Record and then Play buttons (or press
Command-Space bar). If you wish to see what your take looks like, choose the Calculate All
Waveforms command from the File menu and look at your track in the Edit window.

Audio Playlist Selector/Audio Input Selector

This button allows you to select a playlist or an audio input, depending on whether the track is
record-enabled or not. If the track is record-enabled, this button turns into an input selector and
allows you to route one of your system’s inputs to the track. If the track is not record-enabled,
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this button allows you to load different playlists onto the track. (The concept of playlists is
covered in greater detail in later. For now you can simply think of them as alternative “takes” or
tracks.)

&

Automation Record-Enable Button

Clicking this button arms automation recording. To begin recording automation, click the Play
button (you don’t need to click the Transport’s Record button) and move the gain and or pan
fader on the track.

Automation Playlist Selector

This button allows you to select an automation playlist and create, copy, rename or load differ-
ent playlists onto the track. (The concept of playlists is covered in greater later.)

EQ Enable LEDs and EQ Editor Buttons

Each Session track has two built-in digital equalizers (EQs). EQs allow you to enhance the sonic
character of your mix by adjusting the frequency content of audio on a track. You can think of
them as more sophisticated versions of the bass and treble controls on a stereo. To enable an EQ,
click the green EQ enable LED. To select a specific type of EQ, click the white EQ Editor button
and when the EQ editor window appears, adjust EQ parameters as you wish. To close the EQ
window, click its close box. To disable an EQ, click the green EQ enable LED a second time. If a
green EQ LED is lit, you know that an EQ is in use on the track.



Meter Data Selectors/Meter Data Indicator

Clicking on one of the three small LEDs (Fader, Pan, or VU Meter) allows you to choose which
of these types of meter data you wish to view in the Data Indicator field below them. Clicking
the F LED causes the Data Indicator to display information about the track’s current gain fader
setting (monitor level). Clicking the P LED switches the Data Indicator to show the track’s pan
position. Clicking the Vu LED switches the Data Indicator to show the track’s VU level (the
current peak volume of audio on the track). Option-clicking one of these LEDs sets ALL tracks
in the Session to the selected readout (fader, pan, or VU meter value.) To reset the meter data
display, click on it. Option-clicking on the display itself will reset readouts on ALL tracks. If
audio on the track causes the VU meter to “peak,” or go to its maximum value of 0dB, the Data
Indicator will stay at this value until you click on it to clear it. This way, you will always know if
a track has peaked (and potentially has clipped or distorted).

Panning Controller

This slider controls the location of a track in the stereo field. Moving the slider to the left moves
the track’s apparent location to the left. Moving it to the right moves its apparent location to the
right. Holding down the Option key and clicking it sets it to its center position.
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Track Gain Fader and Track Meter

Dragging this fader controls the volume of a track when it is in playback mode, and the monitor
level of the track when it is in record mode. A track’s gain fader doesn’t control the recording
level of a signal—only the monitor level. If you need to increase or decrease the level of your
instrument, use your instrument’s or mixer’s volume control.

Holding down the Option key and clicking this fader sets it to its default position of 0dB.

The red LED above the meter is a clip indicator. It will light up (and stay lit) if you clip during
recording or playback. To clear the clip indicator, simply click on it.

Faolo '

Mute - @

Solo/Mute Buttons

Clicking on the Solo button mutes other tracks so that the selected track can be auditioned alone.
When a track is Soloed, the Mute buttons of other tracks in the session are highlighted. More than
one track can be soloed at the same time. Clicking on the Mute button silences the selected track.
More than one track can be muted at the same time



Edit Window Controls

Zoom Presets

Clicking one of these four Zoom Preset buttons or typing one of the 1-4 numbered keys on the
main section of the keyboard (as opposed to the key pad section) zooms in the track view by a
user-defined amount.

To set a Zoom Preset:

= Use the Zoom Arrows or Zoomer tool (described shortly) to adjust your track view as
you like.

= Hold down the Option key, and click the Zoom Preset button that you wish to assign the
View to.

OR:

= Hold down the Option key, and type the number key (1-4) to correspond to the Zoom
Preset button that you wish to assign the track view to. (Type the number in the main
section of the keyboard as opposed to the key pad section.)

The track view is now stored as a Zoom Preset. Clicking the Zoom Preset button later will zoom in
the track view with the setting you just defined. Zoom Preset buttons can be reset simply by
assigning new track views to them. Zoom Presets are saved with individual sessions, so each session
can have its own presets to suit its particular editing needs.
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The Zoom Arrows

The Zoom Arrows can be used to scale the waveform display in or out. Clicking these buttons
changes the magnification level by a fixed amount each time, and holding them down allows
you to zoom in incrementally. The Zoom Arrows also allow independent adjustment of horizon-
tal (amplitude) and vertical (time) scaling of the viewing area. The Zoom Arrows enlarge and
contract the display, keeping the center point of the display fixed as the scale changes.

Clicking on a Zoom Arrow adjusts the track view in the following ways:

= The up arrow expands the amplitude scale, making the waveform appear taller. This is
useful for viewing low-level audio waveforms. Zooming in to exceptionally high magni-
tude will cause the waveforms of louder sounds to extend well above and below the
viewing area.

= The down arrow performs the opposite function, reducing the height of the waveform.
Use it to scale down your view to see the entire amplitude range of a waveform.

= The right arrow expands the time scale to show greater detail in the waveform display,
making it possible to magnify this view all the way up to single-sample resolution, if you
wish. However, this reduces the visibility of the total session duration.

= The left arrow compresses the time scale, allowing you to see more of the session dura-
tion, but in less detail.

Holding down the Option key while using a Zoom arrow zooms slower. Holding down the
Command key while using a Zoom arrow zooms faster.



The Zoomer

Clicking here or typing the letter z on the keyboard activates the Zoomer. The cursor turns into a
miniature magnifying glass. To use the Zoomer, click and drag this magnifying glass over a
portion of a track that you wish to view. As you drag, a dashed box appears indicating the range
that you will be zooming in on. When you release the mouse, the display zooms in on that
portion.

To Zoom in on a specific part of a waveform:

= Select the Zoomer button or type the letter z on the keyboard. The cursor will change to a
magnifying glass.

= Position the magnifying glass at one end of the area you wish to view in detail. Click and
hold the mouse button, and drag to the other end of the area of interest. A dashed box
extends over the area.

Drag the Zoomer to zoom in on a specific area
that you want to edit more precisely

= Release the mouse button. Session will zoom in on the selected area.

Using the Zoomer with the following commands influences the nature of the zoom:
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= Double-clicking the Zoomer zooms out to display the entire length of the entire session.
= Holding down the Shift key while using the Zoomer zooms in horizontal direction only.

= Holding down the Option key while using the Zoomer zooms from the center out from
wherever you click.

= Holding down the Shift and Option keys while using the Zoomer zooms from the center
out while constraining to horizontal scale.

If the Numeric Editing Mode button (covered shortly) is set to Move mode, you can type in a
number in the Start or End numeric entry fields to adjust the placement of the track view for the
session. If the Numeric Editing Mode button is set to Trim you can adjust only the start or end
time of the track view based on the values that you enter in the Start or End numeric editing
fields. (Pressing the asterisk key (*) on the key pad section of the keyboard will toggle between
Move mode and Trim mode.)

In either Numeric Editing Mode, you can extend the end of the track view and leave the start of
the track view the same by entering the desired selection length in the Duration numeric entry
field. If you precede the number you are typing in any of these numeric fields with a plus or
minus, it will add or subtract from the selection. For example, if you type +250 (Enter) it will add
250 to the value in the selected field.

NOTE: Pressing the Enter key will drop a location Marker if you are NOT editing a numeric field.
So make sure you are in numeric editing mode before pressing the Enter key. (The subject of Mark-
ers is covered later.)



The Selector

Clicking here or typing the letter x on the keyboard activates the Selector. The cursor changes to
an I-beam. Clicking and dragging the I-beam cursor in a track will select that portion of audio
for editing. Double-clicking in a region with the Selector selects the entire waveform within the
region’s boundaries. Once you have made a selection, you can create a region, or modify it with
any of several other editing operations.

Selecting a waveform with the Selector

If the Numeric Editing Mode button (covered shortly) is set to Move mode, you can make a
selection and type a number in the Start or End numeric entry fields to adjusts the placement of
the selection in the session without changing its duration. If the Numeric Editing Mode button is
set to Trim, you can adjust only the start or end times of the selection based on the values that
you enter in the Start or End numeric editing fields, and the duration of the selection will change
accordingly. (Pressing the asterisk key (*) on the key pad section of the keyboard will toggle
between Move mode and Trim mode.)

In either Numeric Editing Mode, you can extend the end of the selection and leave the start of
the selection the same by entering the desired selection length in the Duration numeric entry
field. If you precede the number you are typing in any of these numeric fields with a plus or
minus, it will add or subtract from the selection. For example, if you type +250 (Enter) it will add
250 to the value in the selected field.
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NOTE: Pressing the Enter key will drop a location Marker if you are NOT editing a numeric field.
So make sure you are in numeric editing mode before pressing the Enter key. (The subject of Mark-
ers is covered later.)

Command-Shift-[ will select all the waveform data from the beginning of the region to the
current selector position, and Command-Shift-] will select all the waveform data from the end
of the region to the current selector position.

The Grabber

Clicking here or typing the letter c on the keyboard activates the Grabber. With this tool regions
can be moved or rearranged simply by dragging them to a new location in a track. You can use
this to “spot” regions quite effectively against time scale formats—especially handy if you are
using SMPTE as your time format in the session.

Clicking a region with the Grabber selects the entire region

To trim the length of a region, place the Grabber over either the beginning point (colored red on
the screen) or end point (colored blue) of the region. The Grabber turns into a left/right arrow
that lets you trim the beginning or end of the region. If you

Shift-click to select multiple regions, it will trim all selected regions in relative proportions.



______
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Dragging a region end point with the Grabber
turns into a left/right arrow to resize the region

If the Numeric Editing Mode button (covered in the next section) is set to Move mode, you can
select a region and type in a number in the Start or End numeric entry fields to adjust the place-
ment of the selected region in the session without changing its duration. If the Numeric Editing
Mode button is set to Trim mode, you can adjust only the start and end times of the region based
on the values that you enter in the Start or End numeric editing fields, and the duration of the
selection will change accordingly. (Pressing the asterisk key (*) on the key pad section of the
keyboard will toggle between Move mode and Trim mode.)

In either Numeric Editing Mode, you can extend the end of the region and leave the start of the
region the same by entering the desired region length in the Duration numeric entry field. Se-
lected regions can be moved by entering a location for the region’s Sync point in the Sync nu-
meric field. If you precede the number you are typing in any of these numeric fields with a plus
or minus, it will add or subtract from the selection. For example, if you type +250 (Enter) it will
add 250 to the value in the selected field.

NOTE: In Trim mode typing a value or subtracting to a value in the End field that is earlier than
the Start field will delete the selected region from the track. Similarly, in Trim mode subtracting a
value in the Duration field that is less than the current duration of the selection region will delete
that region from the track.

NOTE: Pressing the Enter key will drop a location Marker if you are NOT editing a numeric field.
So make sure you are in numeric editing mode before pressing the Enter key.
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Command-[ will Trim the waveform data from the beginning of the region to the current selec-
tor position, and Command-] will Trim the waveform data from the end of the region to the
current selector position.

o -

Move Mode Trim Mode

The Numeric Editing Mode Button

Clicking on this button or pressing the asterisk key (*) on the key pad section of the keyboard
(as opposed to the main keyboard section) toggles Session between Move mode and Trim mode.
With Move mode enabled, a selected region or edit range can be moved to a desired location in a
track by typing a value in the numeric entry fields at the top of the Edit window. With Trim
mode enabled, a selected region or edit range can be trimmed to a desired length by typing in a
value in the same numeric entry fields.

The Numeric Editing Fields
These fields function as both data displays and editing controls for a currently selected region or
edit range.

The Start field indicates the start point of the current selection. The End field indicates the end
point of the current selection. The Sync field indicates the Sync point of the selected region (or
the beginning point of the selected region, if there is no Sync point). The Duration field indicates
the duration of the current selection. Information in the fields can be displayed in Bars & Beats,
Minutes:Seconds, SMPTE, or Feet and Frames depending on which Time Scale format is selected in the
Display menu.



The Slash key (/) on your Macintosh keyboard takes you into and toggles through numeric
entry fields, and the Escape key (ESC) exits out of numeric entry fields. A red outline around a
field indicates the current active field for numeric entry editing. Typing new values into any of
these fields and then pressing the Enter key will allow you to enter a new time location for the
selected parameter. Depending on whether the Numeric Editing Mode button (to the left of
these fields) is set to Move or Trim, entering a value in any fields allow you to either Move or
Trim the selected parameter to the time location that you enter. If you precede the number you

are typing with a plus or minus, it will add or subtract from the selection.

The Cursor Position Indicator

The Cursor Position Indicator shows the current position of the Cursor in the Edit window. The
display options are Bars & Beats, Minutes:Seconds, Time Code (SMPTE frames) or Feet and Frames

as chosen in the Display menu. If you wish to display data in Bars & Beats you can use the Iden-
tify Beat command in the Edit menu to provide Session with custom Bar/Beat information.

The Grid On/Off Indicator

The Grid On/Off Indicator shows whether the Grid is currently enabled or disabled. Clicking
the Grid On/Off Indicator turns the Grid on or off. Holding down the Shift key after starting to
drag a region momentarily turns on the Grid and also constrains the region’s horizontal move-
ment when dragged vertically to other tracks.

[ 1 second]
The Grid Value Indicator

The Grid Value Indicator shows the value of the current Grid Mode. Command-up arrow
increases the value in the Grid Value Indicator, and Command-down arrow decreases that
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value. Command-left arrow nudges a selected region to the left by the selected Grid value and
relative to the region’s current position, and Command-right arrow nudges the selected region
or regions to the right by the selected Grid value and relative to the region’s current position.

The Size Read Out Indicator

The Size Read Out Indicator shows the amount of record time, the amount of record space still
available on the hard disk, the size of the session in track minutes, or the size of the session in
hard disk space. The desired format can be chosen with the Size Read Out command in the Dis-
play menu.

[oo-00:00:00 00:00:15:01 00003002 00100 :45 03 00:01 :00:04 00:01 11505

The Time Line

Just above the top most track in the Edit window is the Time Line. The Time Line indicates the
time scale currently in use. Session allows you to display time in several different formats,
including SMPTE Time Code, Bars & Beats, Feet:Frames (for film applications), or
Minutes:Seconds. To change to a different time format, simply choose the desired time format
from the Display menu.

The Solo/Mute Buttons

Clicking on the Solo button mutes other tracks so that the selected track can be auditioned alone.
When a track is Soloed, the Mute buttons of other tracks in the session are highlighted. More than
one track can be soloed at the same time. Clicking on the Mute button silences the selected track.
More than one track can be muted at the same time.



The Fader/Pan/Vu Meter Indicator

Clicking on one of these three LEDs (Fader, Pan, or Vu Meter) allows you to choose which of
these three parameters you wish to view in the Indicator field in both Edit and Mix windows.
Option-clicking one of these LEDs sets all tracks in both Edit and Mix windows to the selected
readout (fader, pan, or Vu meter).

Clicking on the Indicator field below the LEDs will reset the readout on one track in both Edit
and Mix windows. Option-clicking on the Indicator field will reset the same readout on all
tracks in both Edit and Mix windows. Option-Command-clicking on the Indicator field will
reset the readout on one track only in the current window.

The Level Meter

These meters are LED-style meters that show you the level of the signal that is being recorded to
or played back from the hard drive. When a track is record-enabled, these meters are very im-
portant as they are Session’s record-level indicators. Remember that the Session system retains a
clean, quiet signal path by offering no pre-amplification of the input signal. If your input signal
is too low, you must increase it before it reaches the Session hardware (i.e. Audio Card or
PowerPC).

Digital recording produces the best results when the recorded signal is as high as possible without
clipping. In Record mode, these LEDs show you the pre-fader audio level of a track as it records to
hard disk. This means that the meter of a track with audio on it will light up during record regardless
of the setting of the track’s volume fader.
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The Audio Record-Enable Button

Clicking this button arms a track for audio recording. To begin recording audio, click the Audio
Record-Enable button(s) for the track(s) you wish to record, click the Transport’s Record button
and then the Play button. If you wish to see what your take looks like, choose the Calculate All
Waveforms command from the File menu and look at your track in the Edit window.

The Audio Playlist Selector

This button allows you to select a playlist or an audio input, depending on whether the track is
in record or playback. If the track is record-enabled, this button turns into an input selector and
allows you to route one of your system’s inputs to the track. If the track is not record-enabled,
this button allows you to load different playlists onto the track. (The concept of playlists is
covered in greater detail later. For now you can simply think of them as alternative “takes” or
tracks.)

&

The Automation Record-Enable Button

Clicking this button arms Automation recording. To begin recording automation, click the
Automation Record-Enable button(s) for the track(s) you wish to record, click the Play button
(you don’t need to click the Transport’s Record button) and move the gain and/or pan fader on
the track in the Mix window.



The Automation Playlist Selector
This button allows you to select an automation playlist to load different playlists onto the track.
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The Regions List

This is where regions appear after you create them with the Make New Region(s) command or
add them into a session from your hard disk. From here they can be dragged onto tracks and
arranged in whatever order you choose. Region names reflect both the name that you have
given them and the name of the sound file from which they came. At the top of the Audio Re-
gions List is a special region called Silence, which is just that—silence. This region can be placed
in a track, moved, and re-sized like other regions. You’ll learn more about how to use the Silence
region later.

0

The Regions List Window Sizer
If you wish to resize the widow for the Regions List, click and drag the Regions List Window
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Sizer (the left-right arrow box in the top or bottom of the Scroll Bar just to the left of the Regions
List). Enlarging the Regions List window allows you to read the longer region names. Reducing
the Regions List window allows you to see more of the waveform display.

Recording

Beginning a New Session

The first step in beginning a new project is creating a new Session.

To create a new Session:

50

= Choose New Session from the File menu. A dialog appears asking you to name the Ses-
sion.
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The New Session dialog




= Use the pop-up menu at the top of this dialog to navigate to the drive on which you wish to
record. If you have an external drive connected to your computer for recording audio,
navigate to this drive.

= Next, enter a name for the Session and click OK. The Transport appears, followed by the
Edit window.

= To display the Mix window, choose Mix from the Display menu, or type Command-M.

= Click the playlist pop-up menu on the track that you wish to record on and select New. In
the dialog that appears, name your track/playlist. This name will also be given to any
audio files that you record on the track. Click OK to close this dialog.

= Your track/playlist is now named as you wish and you are ready to start your new
project.

Before you jump straight into recording, skim through the next section of your User’s Guide
first. It contains useful information about playlists, an essential part of Session Software’s re-
cording capabilities.

Fename... 3
Delete

Creating a new playlist in order to name a track
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The Name playlist dialog
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Working with Playlists

As you learned earlier, Session allows you to create and load or unload alternative takes on each
of its tracks through the use of playlists. Playlists are extremely valuable in a recording situation

because they give you the opportunity to try out alternative takes on a track, and then later,
choose the one you want to use.

Playlists are accessed by clicking on a track’s Playlist/Input Selector pop-up menu.

Mewr...
Rename...
Delete
Copiy

EE| mone

Audio 2
B sudio T
Audio 4
Audio 5
Audio &
Audio T
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The playlist pop-up menu



When you create a new playlist on a track you can give it a meaningful name such as Vocal 1,
Guitar Solo 3, or whatever you like. You will use this pop-up menu to create, load, and unload
playlists on tracks.

Adding a New Playlist

If you want to create a new, empty playlist to try an alternate take, you can use the New com-
mand in the playlist pop-up menu. When you choose this command, Session will create a new
empty playlist in the current track. If there is already a playlist assigned to this track, it will be
unloaded.

To add a new playlist:

= Click the playlist button on the desired track.

= Choose the New command. A dialog box will appear, allowing you to name the new
playlist.

= Click OK if you want to use the default playlist name or type in one of your own.

= An empty playlist with the name you assigned will be placed in the current track.

Unloading a Playlist

By default, all tracks contain playlists. However, if you wish, you can unload a playlist from a
track, leaving the track empty. This doesn’t delete the playlist—it just isn’t loaded onto that
track any more. This is a useful a way to temporarily open up additional tracks while working
on a complex song. You could for example unload all tracks but one (to use as your guide track)
then load new playlists and record on the other tracks to beef up a specific part such as vocal
harmonies, creating a virtual “wall of sound,” and then bouncing the tracks down to one or two
tracks later.

To unload a playlist:
= Click the playlist button of the desired track. This playlist pop-up menu appears.

53



= Choose None.

The playlist will be unloaded from this track. You cannot record on a track that doesn’t contain a
playlist.

Loading a Different Playlist

With the same pop-up menu, it’s possible to load a different playlist on a track. When you do
this, the playlist which is currently active on the selected track will be temporarily replaced by
the new playlist.

To load a playlist:

= Click the playlist pop-up menu of the desired track. The playlist menu appears.

= Choose the playlist you want to load. Playlists that are already loaded onto other tracks
cannot be selected. The playlist you choose will be loaded onto the selected track.

When a playlist is unloaded, it still exists in the session and can be reloaded at any time. If you
really want to get rid of a playlist, however, Session does allow you to delete playlists from a
Session. You’ll learn how to do this next.

Deleting a Playlist

If you wish, you can delete a playlist from a session entirely. You may want to do this after
experimenting with a particular arrangement of regions that didn’t quite suit your needs. How-
ever, since playlists take almost no disk space, don’t delete them for space reasons. You may just
want to unload a playlist to get it out of the way. If you decide you want it later, you can load it
up again.

To delete a playlist currently loaded on a track:

= Click the playlist pop-up on the desired track.



= Choose the Delete command. A dialog will appear asking you if you’re sure you want to
proceed.

= |f you’re sure you want to delete the playlist, click Yes or press return. The playlist will
be deleted. This operation cannot be undone.

Renaming Playlists

By default, playlists are automatically named audio 1, audio 2, and so on. However, you can
assign more meaningful names like “lead vocal,” “rhythm guitar,” etc. These customized names
will then appear on the track.

To rename a playlist currently loaded on a track:

= Click the playlist button on the desired track.
= Choose Rename. A dialog will appear prompting you to rename the current playlist
= Enter a new name and click OK. The playlist will be renamed.

Now that you have learned how to create and manage playlists, the next step is recording audio
onto them.

Initiating Recording

In many ways, your first track is the most important track in a multitrack recording project
because it forms the framework upon which all other tracks are built. If the basic timing of your
first track is sloppy, the entire production could be affected.

The production cycle of a recording session typically progresses something like this. Set record-
ing and monitoring levels and record your first track. Play back track 1 to make sure you like it,
and set its volume level. Next, record track 2 while listening to track 1. Now play both tracks
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back while recording track 3. Follow this same procedure for all subsequent tracks. With this in
mind, You’re ready to begin recording.

To record an audio track:

= If you’'re just beginning a recording session, choose Hardware Setup from the Setup menu
and click Recalibrate Inputs. This will help eliminate any DC Offset that may have built up
in your system’s analog-to-digital converters. (DC Offset is an imbalance that sometimes
occurs in miscalibrated digital-to-analog converters. It can cause loss of headroom in
recording and click and pops during editing.)

= Make sure that your audio source is connected to your computer. If you are using a
Power Mac’s built-in inputs, connect your source (ideally your mixer’s output) to the
Sound Input jack on the rear of your computer. If you are using an Audiomedia Il card,
make sure your mixer or preamp is connected to the input jacks of the Audiomedia card.

= In the Mix window, click the R button on the track that you wish to record on. This will
record enable the track. The button turns red, indicating that the track is ready for record-

ing.

= Click the Input Selector pop-up and choose the desired input (Input 1 or Input 2). Input 1 is
the left channel. Input 2 is the right channel.




= Adjust your fader level and panning. These settings will not affect how your audio is
recorded to disk, they are just for monitoring purposes. Session Software conveniently
allows you to set two different fader levels: one for when you are recording (when the
record enable button is depressed), and one for when you are simply playing back (when
the record enable button is NOT depressed). This way, your original “rough mix” levels
won’t be disturbed if you need to raise your monitor level during recording.

= If you are using a Power Mac’s built-in audio capabilities, Session’s track faders only
allow two monitor levels: on or off—that is, full volume or zero volume. This is a limita-
tion of the Power Mac’s sound chip. Thus, if a track’s monitor level fader is set anywhere
above zero, audio is passed through at full volume. If a track’s monitor level fader is set
at zero, audio is not passed through for monitoring. (The audio is still recorded to disk,
but you just can’t hear it through the Apple Sound Manager.)

= Adjust the input level of your instrument, mixer, or preamp. Watch your Session track
meter to get the highest possible level without clipping. (If you clip during recording, the
clip indicator LED will light up and stay lit.)

= Click the Record button on the Transport. It turns red, indicating it is armed for recording.

00:00.000)

= When you’re ready to start, click the Play button on the Transport. You are now record-
ing to disk. (You can also press Command-Space bar to initiate recording.)
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= When you have finished your take, click the Transport’s Stop button or press the Space
bar on your computer keyboard to stop recording.

To play back your tracks:

= Click the R button on your track once again to take it out of record-enable.

= Click Play on the Transport or press the Space bar to begin playback. Adjust playback levels
as you wish.

At this point, if you wish to retry your take, you can record another take and create a new audio
file. Because Session records tracks “nondestructively,” your previous take will not be erased
when you record again. Previously recorded takes always remain on your hard drive (and in the
Edit window’s Audio Regions List) as separate sound files unless you specifically decide to delete
them. Session will give each new audio file the name of the track/playlist you recorded it on,
and add a number to it (a higher number for each subsequent take you perform). This nonde-
structive recording capability gives you a great deal of flexibility since you can record take after
take and decide later which ones you’d like to use.

To nondestructively record a new take on the same track or tracks:

= Repeat the steps outlined above for recording a track. If you look at your tracks in the
Edit window, you will see that each new take is “stacked” on top of the previous take on
the track.

If you like, you can begin recording at any point in time within a file simply by going to that
point (either with the Transport, or by going to the Edit window and clicking the Selector at the



desired point) and commencing recording in the same way as above. Session also provides a
precise way of performing “punch-in” recording using the tools in the Edit window.

Recording In Stereo

Session allows you to record two tracks at the same time. One of the most useful applications for
recording two tracks simultaneously is recording vocals or instruments in stereo. If you plan to
record an instrument in stereo, you must use two tracks so that you can capture both the left and
right channels of the stereo S|gnal When you play the tracks, remember to pan one track full left
and the other full right to preserve the stereo image.

To record an instrument in stereo:

= Connect your instrument’s stereo outputs to your system. (Ideally, connect the
instrument’s outputs to a mixer and connect the outputs of the mixer to your computer).

= Open the Mix window by choosing Mix from the Windows menu or pressing Command-
M on your keyboard.

= In the Mix window, click the record-enable button on both of the tracks that you wish to
record on. They turn red, indicating that the tracks are record-enabled.

= Click each of the tracks’ Input Selectors to route the appropriate inputs to the tracks.
Assign track 1 to Input 1 (for the left channel). Assign track 2 to Input 2 (for the right
channel).

= Adjust the panning of your two inputs so that one is panned full left and the other is
panned full right. This will allow you to monitor the take in stereo.

= Play your instrument and adjust its output level.

= Click the Record button on the Transport. It turns red, indicating that you are ready to
record.

= When you are ready to begin, click the Transport’s Play button. You’re now recording to
hard disk. (You can also press Command-Space bar to initiate recording.)
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= When you have finished your take, click the Transport’s Stop button or press the Space-
bar on your computer keyboard to stop recording.

Editing

Understanding Audio Waveforms on Screen

When you record a take, Session displays a picture of the sound that makes up the take. If
you’ve never seen an audio waveform before, this graphic “waveform overview” of the data
may seem strange to you. The following explanation will help you understand what you’re
looking at. Before you go any further though, you should learn how to display your tracks as
waveforms in the Edit window. Here’s how you do this:

To display all tracks as waveforms in the Edit window:

= From the Display menu, choose Waveforms. A check next to this item indicates that it is
enabled.
= From the Options menu, choose Auto Calculate Waveforms. A check next to this item

indicates that it is enabled. When this option is enabled, Session will automatically calcu-
late the waveforms for every new sound file you record or add or import into the session.

OR:

= From the File menu, choose Calculate All Waveforms. After a moment your tracks appear
as waveforms. If the Auto Calculate Waveforms command is not chosen from the Options
menu, you must do this each time you record a new track in order to see a waveform

representation of your track.
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To create a waveform overview for a specific sound file in a track in the Edit window:

= From the Display menu, choose Waveforms. A check next to this item indicates that it is
enabled.

= With the Grabber, click on the sound file that you wish to create a waveform overview
for. If you wish to select more than sound file, hold down the Shift key while you click on
multiple items.

« From the File menu, choose Calculate Selected Waveforms. After a moment the selected
sound file(s) appear as waveforms in the tracks where they are located.

To get a better look at the waveforms, you can change the size of the tracks as they are shown in
the Edit window. Four track sizes (Micro, Small, Medium, or Large) may be selected from the
Display menu. Changing the track size can reduce the size of all tracks on screen to roughly half
of the default height (Small) or increase the size to almost four times the default height.

To select the track size shown in the Edit window:

= From the Display menu, choose one of the four track sizes:

= Micro Tracks, half the height of the default track size;

< Small Tracks, the default track size for newly created sessions;
= Medium Tracks, twice the height of the default track size; or,

= Large Tracks, four times the height of the default track size.

When you look at a waveform of one of your tracks in the Edit window, you’re basically seeing a
diagram of your recorded sound. This picture tells you several things about the sound. For example,
take a look at the following illustration, which shows a typical waveform.
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A typical audio waveform

This is a recording of some music with a standard 4/4 beat. The “peaks” that you see are actu-
ally beats—places in the recording where the volume goes up momentarily. These are followed
by “valleys” where the volume goes down.

Different types of sounds produce different types of waveforms. Drums, for example, generally
produce the kind of waveform you see in the illustration: sharp peaks of short duration which
are very clearly defined. If you think about a drum’s sound, you’ll understand why: A drum hit
has a loud, sharp attack, and a rapid decay. Other sounds, such as a vocal or a keyboard pad,
produce a very different waveform, one that has less pronounced peaks and valleys. That’s
because these sounds generally have softer attacks and longer decays. Using Session’s Selector
tool, you can select portions of these waveforms and divide them into segments called regions, so
that you can rearrange and manipulate them in tracks.

Getting back to our illustration, let’s look at a typical waveform selection. Notice that the se-
lected range begins before a peak and ends immediately before a peak. This illustrates one of the
golden rules for defining a music region:

A typical one-beat selection

= Whenever possible, select a region precisely before a volume peak, and end it immedi-
ately before another volume peak.



Here is a second rule:

= Whenever possible, make sure a region starts and ends on exactly the same part of a
beat.

ACHO! 0 I
___.-! _.in

A four-beat selection

One of the most important things to remember while you are editing music with Session is to
create regions that allow you to maintain a consistent beat. If the beat or rhythm is not main-
tained when you place several regions next to each other and play back the track, it will seem to
“skip” like a broken record. If you always define regions so that they contain a whole number of
beats (1 beat rather than 1.3 beats, for example), you’ll be able to string all of these regions to-
gether and maintain a smooth, steady rhythm.

It’'s sometimes useful to use a very steady, well-defined waveform, such as a drum track, as a
guide when you select and define other regions. If you’ve played in time with the beat, chances are
that you can create rhythmically accurate regions by referring to the drum’s waveform.

Note: Session’s Grid Mode provides a way to have the Selector “snap-to” Bar/Beat MarKkers, time
code and even other tracks. (Grid mode is explained later.)

Here is one final important tip for creating useful regions:

= In order to avoid clicks or pops at the beginning or end of any regions that you define,
try to make sure that the start and end points of your selection are as close as possible to
the point where the amplitude of the waveform tapers down to meet the “zero-crossing
line” (the center line of your track’s waveform display).
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If you don’t do this, and the selection begins or ends at a point of high amplitude in the region,
you may hear an unpleasant click when Session plays from one region to another. Use the Zoom
Arrows and Zoomer to zoom in very closely to make a precise edit such as this, and use the four
Zoom preset buttons to remember track views you find most useful for your editing needs.

Notice how the selection begins and ends where the waveform meets the
“zero crossing” or center line. This type of selection helps avoid pops and clicks.

These tips will start you on your way to understanding and creating regions that are easy to use.
As you work with Session, you’ll undoubtedly develop additional editing techniques of your
own.
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Working with Playlists

When you record a track, a sound file is created on that track. If you choose the Calculate All
Waveforms command and look in the Edit window, you’ll see the sound file’s waveform on the
track where it was recorded. At this point, you have the option of dividing the sound file into
regions and arranging these into a different order. This is called creating a playlist. A playlist is
nothing more than a particular arrangement of regions on a track. A playlist can consist of a
single region or many regions. For all intents and purposes you can think of a playlist as an



alternative “take” where things are simply rearranged into a different order. Session allows you
to create many of these different arrangements or playlists and load or unload them onto tracks

as you wish. Playlists are accessed by clicking on a track’s Playlist/Input Selector button.

To load a playlist:

= Click the Playlist button of the desired track. This menu appears:

Mewe....
Renarne...
Celete
Copy

Mane

Audio 2 *

Audio 3
Audio 4

The Playlist pop-up menu

= Choose a playlist. The playlists are numbered successively Audio 1, Audio 2, Audio 3,
Audio 4, and so on.

The playlist will be loaded onto this track. You can name a playlist to give it a meaningful name
such as Drums, Guitar Solo, or whatever you like. By changing playlists you can load and unload
different arrangements of regions on a track. The Playlist pop-up menu is what you use to
change the assignments of playlists to tracks.

Unloading a Playlist

By default, all tracks contain playlists. However, if you wish, you can take a playlist out of a track,
leaving the trackempty. Thisdoesn’tdelete the playlist—itjustisn’tloaded onto that track any more.
Thisisauseful way to temporarily open up additional tracks while working on acomplex song. You
could forexample unload all tracks but one (to use as your guide track) and use the remaining tracks
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to beef up a specific part such as vocal harmonies, creating a virtual “wall of sound,” and then
bouncing the tracks down to one or two tracks sometime later.

To unload a playlist:

= Click the Playlist button of the desired track. The Playlist menu appears.
= Choose None.

The playlist will be unloaded from this track. When a track does not contain a playlist, it turns
white in the Edit window. In the Mix window, tracks without playlists simply have no name,
and their Record-enable buttons are grayed-out. You cannot record on a track that doesn’t
contain a playlist.

Loading a Different Playlist

With the same pop-up menu, it’s possible to load up a different playlist on a track. When you do
this, the playlist which is currently active on the selected track will be temporarily replaced by
the new playlist.

To load a playlist:

= Click the Playlist button of the desired track. The Playlist menu appears.

= Choose the playlist you want to load. Playlists that are already loaded to other tracks
cannot be selected. The playlist you choose will be loaded to the selected track.

When a playlist is unloaded, it still exists in the session file and can be reloaded at any time. If
you really want to get rid of a playlist, however, Session does allow you to delete playlists from
a session. You’ll learn how to do this later.

Adding a New Playlist

If you want to create a new, empty playlist to begin experimenting with different arrangements
of regions, you can use the New command in the Playlist pop-up menu. When you choose this



command, Session will create a new empty playlist in the current track. If there is already a
playlist assigned to this track, it will be unloaded.

To add a new playlist:

= Click the Playlist button on the desired track.

= Choose the New command. A dialog Indicator will appear, allowing you to name the
new playlist.

= Click OK if you want to use the default playlist name or type in one of your own.

= An empty playlist with the name you assigned will be placed in the current track.

Deleting a Playlist

If you wish, you can delete a playlist from a session entirely. You may want to do this after
experimenting with a particular arrangement of regions that didn’t quite suit your needs. How-
ever, since playlists take almost no disk space, you don’t need to delete them for space reasons.
You may just want to unload a playlist to get it out of the way. If you decide you want it later,

you can load it again.
To delete a playlist currently loaded on a track:

= Click the Playlist button on the desired track. A pop-up menu appears.

= Choose the Delete command. A dialog will appear asking you if you’re sure you want to
proceed.

= |f you’re sure you want to delete the playlist, click Yes or hit return. The playlist will be
deleted. This operation cannot be undone.

Renaming Playlists
By default, playlists are automatically named Audio 1, Audio 2, and so on. However, you can
assign more meaningful names like “lead vocal,” “rhythm guitar,” etc. These customized names

will then appear on the track.
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To rename a playlist currently loaded on a track:

= Click the playlist button on the desired track.
= Choose Rename. A dialog will appear prompting you to rename the current playlist
= Enter a new name and click OK. The playlist will be renamed.

Now that you have learned how to create and manage playlists, the next step is creating regions
to put into your playlists. Because regions are the basis of every track in your session, learning
how to create, edit, and arrange them is essential to using Session to its full potential.

Before you get started creating and editing regions, keep in mind once again that all editing that
you do with Session’s editing tools is non-destructive. Whether you are cutting, pasting, resizing
or deleting regions, your source audio files remain safe, so don’t be afraid to experiment.

Auditioning Tracks

Before you create any regions, you’ll probably want to audition various points in your track to
see which sections would make good regions. You can do this quickly by clicking the Selector at
a given location in a track and starting playback from there. Before you begin, make sure that all
of your tracks are displayed as waveforms. (If necessary, use the Calculate All Waveforms com-
mand in the File menu.)

To set the playback point and start audio playback:

= In the Edit window, click on the Selector or type the letter x to activate the Selector. The
cursor turns into an I-beam.

= Click once and release the mouse button at any point in a track.

= Press the Space bar to begin playback from this point. To stop playback, hit the Space bar
again.



If you want to jump to a different location in your track, simply click the Selector at that point
and press the Space bar again.

If you want the playback cursor to follow a track as it plays back and stop where playback stops,
do the following:

To make the playback cursor follow audio playback:

= Choose Insertion Chases Playback from the Options menu.

= Click on the Selector, or type the letter x to activate the Selector. The cursor turns into an
I-beam.

= Click once and release the mouse button at any point in a track.

= Press the Space bar to begin playback. The playback cursor will follow playback of the
track and stop where playback stops.

Page Scrolling and Power Scroll
If you want the tracks and the Time Line to scroll during playback, you can choose between
Session’s two scroll modes: Page Scrolling and Power Scroll.

Page Scrolling updates the track and Time Line “page” each time the playback cursor finishes
rolling across the screen during playback. The playback cursor will then play across a new page
representing the current audio data, repeating this each time the screen needs updating.

2 0000 1505 00:00:19 28 00:00:20 21 00:00 21 114

—
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Page Scrolling
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Power Scroll allows the playback cursor to remain stationary in the middle of the screen while
the tracks and the Time Line roll continuously underneath.

+——

> 0014001115 105 00001928 A 00 20 21 000021 114

A

ot

Power Scroll

To make the screen scroll during playback:

= Choose either Page Scrolling or Power Scroll from the Options menu. Selecting one of the
scroll modes automatically disables the other. A check next to one of these items indicates
that it is enabled.

= Click the Selector. The cursor turns into an I-beam.
= Click once and release the mouse button at any point in a track.

= Press the Space bar to begin playback. The screen will scroll during playback according
to the mode selected.



To stop the screen from scrolling during playback:

= Choose either Page Scrolling or Power Scroll from the Options menu if one of those items
is enabled. A check next to one of these items indicates that it is enabled. Selecting an
enabled item automatically disables it.

About Session’s Two Edit Selection Modes

Session’s Edit window has two selection modes that are always active and are interchangeable by
selecting their corresponding Editing tools: the Selector and the Grabber.

In later sections, you will learn how to use both the Selector and the Grabber to accomplish
different edits. The Selector establishes the playback position and highlights waveform areas
within a region’s boundaries for editing. Anything you want done to the waveform of a sound
file—playing, looping, fading, defining Markers, defining new regions—can be accomplished
with the Selector. The Grabber on the other hand primarily selects portions of sound files that
are defined as regions. Since regions are entities with boundary parameters, they can be
“grabbed” and subsequently Moved, Re-sized, Deleted, Cut, Copied, Pasted, and so on.

Because the Selector and the Grabber allow you to perform different duties, Session keeps both
these selection modes active for editing flow and versatility—so you don’t lose any work and
time in one mode when switching to the other. For example, you can use the Selector to high-
light a waveform area for loop playback and then use the Grabber to move or resize a region to
position against your highlighted selection. Even though the Grabber may be the current selec-
tion tool, the highlighted area remains selected and active, so playback still follows the high-
lighted selection.

USER TIP: Pressing the z, x and c keys on the Macintosh keyboard allows you to conveniently
toggle between the Zoomer, the Selector, and the Grabber respectively.
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Selecting Waveforms

Once you’ve found a portion of your sound file that you want to make into a region, the next
step is to select that portion of the sound file with the Selector. Keep in mind some of the points
you learned about creating “musical” regions.

To select a waveform:

= Make sure a sound file is visible on one of your tracks in the Edit window.
= Click on the Selector, or type the letter x to activate the Selector.
= Position the Selector at one end of the selection you wish to make.

= Click and drag the mouse left or right. The selection range will change as you move the
mouse.

= When the selection encompasses the desired range, release the mouse button. The selec-
tion is complete. As you can see, selecting waveforms is easy when you can see the wave-
form data.

Selecting a waveform

Note: Session’s “Grid” Mode provides a way to have the Selector “snap-to” Bar/Beat values, time
scales and region boundaries on other tracks.



To make a selection “on the fly” during playback:

= Make sure a sound file is visible on one of your tracks in the Edit window.
= Click the Selector at the beginning of the track in which you want to make the selection.
= Press the Space bar or click the Transport’s Play button to start playback.

= As your track plays, press the down arrow key on your Macintosh keyboard at the point
where you want the selection to begin. Press the up arrow key at the point where you
want the selection to end.

= To stop playback, press the Space bar. The waveform range that you selected will appear
highlighted on the track.

= To automatically scroll the display to the beginning of the selection, press the left arrow
key. To scroll the display to the end of the selection, press the right arrow key.

Changing the Length of a Selection

If you change your mind and want to make a selection a little longer or shorter you can easily do
this. Simply hold down the Shift key and click and drag the mouse at the beginning or end of the
selection you wish to extend.

To change the length of a selection:

= Position the Selector over one end of the current selection and press and hold the Shift
key.

= Click and drag the mouse. The range of the selection will change as you drag the mouse.
= When you have adjusted the selection to the desired size, release the mouse button.

When Grid mode is enabled, the length of the selection changes by the current Grid value. If you
wish to extend the selection to a location Marker, simply Shift-click on the Marker.

This Shift-drag technique is also very handy when you want to make a very long selection.
Here’s how you can put it to good use:

73



74

To quickly make a lengthy selection:

= Use the Selector to click where you want the selection to start.

= Release the mouse button and then scroll to the desired end point. (The beginning of
your selection will probably scroll out of sight, but don’t worry—it’s still there.)

= Hold down the Shift key, and click at the desired end point. Release the mouse button,
and you will have made your lengthy selection.

Remember, when using the Selector you can also use the Numeric Entry Editing to change the
length of your selection. If you type values in numeric editing fields at the top of the screen, you
can adjust the length of selection accordingly:

= The Slash key (/) on your Macintosh keyboard takes you into and toggles through
numeric entry fields, and the Escape key (ESC) exits out of numeric entry fields. A red
outline around a field indicates the current active field for numeric editing. After you
type in a number, press the Enter or Return key on your keyboard and Session will adjust
the selection according to the values you have entered.

= |f the Numeric Editing Mode button is set to Move mode , you can make a selection
and type a number in the Start or End numeric entry fields to adjust the placement of the
selection in the session without changing its duration.

==

- If the Numeric Editing Mode button is set to Trimmode ~ , you can adjust only the
start or end time of the selection based on the values that you enter in the Start or End
numeric editing fields, and the duration of the selection changes accordingly.

= In either Numeric Editing Mode, you can extend the end of the selection and leave the
start of the selection the same by entering the desired selection length in the Duration
numeric entry field.



= |f you precede the number you are typing in any of these numeric fields with a plus or
minus, it will add or subtract from the selection. For example, if you type +250 (Enter) it
will add 250 to the value in the selected field.

NOTE: Pressing the Enter key will drop a location Marker if you are NOT editing a numeric field.
So make sure you are in numeric editing mode before pressing the Enter key.

Selecting Waveforms Across Multiple Tracks

A selection can be made across multiple tracks. This is convenient if you want to select regions
of the same length on several tracks at once.

To Select across multiple tracks:

= Begin your selection on the top or bottom track you wish to include in the selection.

= As you drag the mouse, simply move it upwards or downwards over the adjacent
track(s). The selection now includes multiple tracks.

= Continue dragging until you’ve selected the area you want, then release the mouse
button.

Dragging the mouse over adjacent tracks
to make a selection across multiple tracks
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If you have a selection on one track that you wish to extend across multiple tracks, you can keep
the selected range horizontally constrained by doing the following:

To extend a horizontally constrained selection across multiple tracks:

= Select a portion of a waveform on one track.

i

Selecting a portion of one track to extend across multiple tracks

= Hold down the Shift key, and click on the Volume Axis (left of the waveform display
window) next to the track you wish to extend the selection to. The selection from the
original selected track will extend across to the newly selected track and remain con-
strained to its original range.

Clicking on the Volume Axis to extend a horizontally constrained selection



All tracks between the original and newly selected tracks will also be selected. If you want the
selection to extend across only certain playlists, then load the playlists to adjacent tracks before
extending the selection.

USER TIP: To select all the audio from the cursor to the next region boundary, press Shift-Tab. To
select all the audio from the cursor to the previous region boundary, press Shift-Option-Tab. To
select all audio to the left of the cursor, choose the Select Left of Current command
(Command-Shift-[ ) in the Edit menu. To select all audio to the right of the cursor, choose the
Select Right of Current command (Command-Shift-] ) in the Edit menu. This can be handy for
creating Fades Ins and Outs.

Creating New Audio Regions

You are now going to learn how to create your own regions. Session provides you with several
commands for doing this, including the Make New Region(s) command and the Separate Region
command. Both of these commands differ in their effect on a selection.

The first of these commands, the Make New Region(s) command, defines a selection as a new
region. The new region then appears in the track (on top of the sound file from which it was
created) and in the Regions List at the right of the screen.

To create a new region with the Make New Region(s) command:

= Click on the Selector, or type the letter x to activate the Selector.
= Click and hold the mouse button where you want the region to begin.

= Drag the mouse to select the portion of the waveform that you want to capture as your
region.
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Selecting a waveform

= Release the mouse button where you want the region to end.

= Choose Make New Region(s) from the Edit menu. When Session prompts you to name the
region, enter a name and click OK.

Name the new region :

Drums |

Cancel I 114 I

Naming a new region

Your new region will appear both in the track and in the Audio Regions List at the right of the
screen. If you look at the new region’s name in the Regions List, you will see that it has the name
that you just gave it. All region names are actually composed of two parts: the name of the sound
file from which it came and the region name you gave it. Regions can be renamed later, either by
clicking on their names in the Audio Regions List or by clicking on the region itself in a track.

The Separate Region Command

The next of these commands, the Separate Region command, defines a selection as a new region
and in the process, separates it from audio data adjacent to it. The new region then appears in
the track, separate from the sound file from which it was created, and in the Regions List at the
right of the screen. By separating a region you will also create “by-product” regions from data
on either side of the separation. These regions also appear in the Regions List.



To separate a region with the Separate Region command:

= Click on the Selector, or type the letter x to activate the Selector.
= Click and hold the mouse button where you want the region to begin.

= Drag the mouse to select the portion of the waveform that you want to separate as a new
region.

= Release the mouse button where you want the region to end.

Making a selection to Separate as a new region

= Choose Separate Region from the Edit menu (Shift-Command-R). When Session prompts
you to name the region, enter a name and click OK.

rum Toop-3

A Separated Region

The new region will appear in the track in which it was created, separate from the data sur-
rounding it. As with all regions, it will also appear in the Regions List at the right of the screen.
From there it can be dragged into other tracks. Note that by separating the region you have
created “by-product” regions from data on either side of the separation. These regions also
appear alphanumerically by region name in the Regions List.
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USER TIP: To select audio from a cursor positioned within a region to the end of the region, press
Shift-Tab. To select audio from a cursor positioned within a region to the beginning of the region,
press Option-Shift-Tab. This is handy for creating Fades Ins and Outs for regions.
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Placing a Region in a Track

Once you have created a region, it appears in the Audio Regions List at the right of the Edit
window. From here you can drag it into a track to add to an existing playlist or create a new
playlist and start from scratch. The exact placement of a region in a playlist depends on the
current Grid setting. Grid modes will be explained later, but for now, Grid mode should be set

to Off.
To place a region in a playlist:

= Click on the Grabber, or type the letter c to activate the Grabber.
= Click and hold the Grabber on the name of a region in the Audio Regions List.
= Drag the highlighted region name from the Audio Regions List into the desired track.

= When the region is in position over the desired track, release the mouse button. The new
region will be added to the playlist in that track.

If you want, you can drag multiple regions from the Audio Regions List at the same time by
Shift-selecting them. Each region will be placed in a different track, if available. This technique is
useful for bringing regions that are part of a stereo pair (the right and left channels of an instru-
ment recorded in stereo) into two tracks while keeping them lined up together in perfect phase.



Session also allows you to place regions from different sound files into the same track. Unless
you’re running low on tracks, it is probably more useful to keep all the regions of a particular
musical part (such as a vocal) in separate tracks for simplicity’s sake.

Selecting an Entire Region

Now that you have placed your region into a new playlist, you can manipulate it in a number of
ways such as moving or resizing it. In order to move, resize, or delete a region, you must use the
Grabber to select the entire region and then perform one of these actions.

To select an entire region with the Grabber:

= Click the Grabber, or type the letter c to activate the Grabber.
= Click anywhere inside the region you want to select.

The region’s outline box appears in bold, as shown below. This indicates that the region is now
selected. Later, you’ll learn to resize regions by dragging their start and end points.

A selected region (selected with the Grabber tool)

Another technique exists for selecting entire regions, this one using the Selector tool. When you
use the Selector to select an entire region, the entire region’s waveform will be selected (not just
the region boundary as when you use the Grabber). Generally you’ll want to use the Selector to
select an entire waveform for making Fades and Bar & Beat Markers that span the entire region
(and use the Grabber to edit an entire region definition by moving, resizing, or deleting).
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To select an entire region with the Selector:

= Click on the Selector, or type the letter x to activate the Selector.

= Double-click anywhere inside the region you want to select. The entire region’s wave-
form will be selected as in the following example, in which the region Drums: Kick was
double-clicked with the Selector:

rums Loop *

A selected region (selected with the Selector tool)
The Selector tool also lets you quickly select the silence between regions simply by double-clicking.
To select a silence gap:

= Click on the Selector, or type the letter x to activate the Selector.

= |dentify a silence gap which you want to select. In the following example, we’ve zoomed

in on a silence gap within the drum track of the Demo session:

s kick urns snare

A track with silence gaps



= With the Selector, double-click in the silence gap. The entire silence gap will be selected:

A silence gap selected by double-clicking with the Selector tool

Selecting Multiple Regions
You can select, move, or resize more than one region at the same time by first selecting multiple
regions with one of these techniques:

To select multiple regions:

= Click the Grabber, or type the letter c to activate the Grabber.
= Click a region to select it.

= Hold down the Shift key and click another region. Now both regions are selected. Repeat
as necessary.

= Shift-clicking an already selected region allows you to deselect it.

If you want to select all the regions to the right or left of the currently selected region, use the
Left of Current or Right of Current command in the Select sub-menu in the Edit menu.

To select all regions to the left of a selected region:

= Click the Grabber, or type the letter c to activate the Grabber.
= Click a region to select it.

« From the Edit menu choose the Left of Current command in the Select sub-menu in the
Edit menu.
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= All regions to the left of the selected region are selected.

To select all regions to the right of a selected region:

= Click the Grabber, or type the letter c to activate the Grabber.

= Click a region to select it.

= From the Edit menu choose the Right of Current command in the Select
sub-menu in the Edit menu.

= All regions to the right of the selected region are selected.

Deleting Regions From a Playlist

A region, or group of regions may be deleted from a playlist at any time. When a region is
deleted from a playlist, the actual digital audio on the drive is unaffected, so deleting regions
from playlists won’t help you save any space on your hard drive. Deleting a region from a
playlist won’t even delete the definition of that particular region. If it’s used elsewhere in the
session, other occurrences of the region will remain unchanged. Deleting a region just means
that the region won’t appear in that particular spot in your playlist anymore.

To delete a region from a playlist:

= With the Grabber, select the region you wish to delete. If you wish to select multiple
regions, hold down the Shift key and click additional regions.

= Press the Delete key on the keyboard.
If you change your mind, this operation can be undone with the Undo command.

IMPORTANT

84

Remember that Session has two selection modes that are always active: the Selector and the
Grabber. Regions can only be deleted when selected with the Grabber. If you selected a region



with the Selector with the intention of deleting it and the Grabber has another region selected, press-
ing the Delete key will only delete the region selected by the Grabber and not by the Selector.

Deleting Regions From the Audio Regions List

A region can only be deleted from the Audio Regions List if it is not used in the current session.
This is true even if the playlist that the region is being used in is not currently loaded on a track.
When you delete a region from the Audio Regions List, you won’t see it in that session again
unless you add that region back into the session with the Add Audio File(s) command.

To delete a region from the Audio Regions List:

= Delete the region from all playlists (loaded or unloaded) in the current session.
= Select the region in the Audio Regions List.
= Choose the Delete Region(s) command from the Edit menu.

= If the region is not currently in use in a playlist, it will be removed from the Audio Re-
gions List.

Cutting Regions

With the Cut command you can “cut” an entire region out of its current position. The Macintosh
holds it on the Clipboard (the Macintosh’s internal memory) in case you want to paste it else-
where. Of course, since editing in Session is nondestructive, you aren’t actually cutting data
from the original audio file, but the effect is the same as if you were.

To Cut an entire region:

= Click the Grabber, or type the letter c to activate the Grabber.
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= Click on a region to select it.
= From the Edit menu, choose the Cut command (Command-x).
= The region is removed and placed on the Macintosh’s Clipboard.

Copying Regions

The Copy command is much like the Cut command, but instead of removing the selected region,
it leaves the original, and places a copy of it in the Macintosh’s Clipboard so that you can paste it
elsewhere.

To Copy an entire region:

= Click the Grabber, or type the letter c to activate the Grabber.

= Click on a region to select it.

= From the Edit menu, choose the Copy command (Command-c).
= The region is copied and placed on the Macintosh’s Clipboard.

Session provides you with a handy shortcut for copying and placing a whole region in a new
location. You may be familiar with this technique if you’ve ever used a Macintosh graphics
software: Option-drag. With this technique you simply hold down the Option key, select a
region, and drag a copy of it to a desired location.

To Copy a region with the Option key:

= Click the Grabber, or type the letter c to activate the Grabber.
= Hold down the Option key.

= Click and drag the region you wish to copy to a new location. A copy of the selected
region will appear in the new location. The original will remain in its original location.



Pasting Regions

By using the Paste command, you can insert a copied region into a location that you have chosen
with the Selector. It is only possible to paste a region after it has been cut or copied to the
Macintosh’s Clipboard.

To Paste a region:

= Click the Selector, or type the letter x to activate the Selector.

= Click the Selector at the point where you wish to insert the audio data in a track. Alter-
nately, click and drag to select a waveform range that you wish to replace with the pasted
data.

= From the Edit menu, choose the Paste command (Command-v).

The Clipboard contents are inserted into the selected track(s), beginning immediately after the
blinking insertion point and overlapping any regions at the same position in the session.

Clearing Regions
The Clear command allows you to remove a selected region.

To Clear an entire region:

= Click the Grabber, or type the letter c to activate the Grabber.

= Click on a region to select it.

= From the Edit menu, choose the Clear command, or press the delete key.
= The region is removed from the track.

If you change your mind, this operation can be undone with the Undo command.

87



NOTE: Pressing the Delete key is another quick way to clear a selection or region from a track.

Duplicating Regions

The Duplicate command copies a selection and places it immediately after the end of the selec-
tion in a track. It provides you with a very handy way of repeating a region (to create a drum
“loop,” a repeating bass figure, etc.,) and is faster and more convenient than copying and past-
ing data to achieve the same result—particularly if you want to duplicate data on multiple
tracks. Use one of the Shift-click techniques explained earlier to select multiple regions on mul-
tiple tracks.

To Duplicate an entire region:
= Click the Grabber, or type the letter c to activate the Grabber.

= Click on a region to select it.
« From the Edit menu, choose the Duplicate command (Command-d).

The duplicated data will be placed directly after the end of the selection. Data occurring after it
will remain in the same track position, and the duplicated data will overlap any adjacent data.
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Moving Regions

A region, or group of selected regions can be moved together. Multiple regions in the same
playlist, or different playlists can be moved as a group. Remember that the movement of regions
Is constrained by the current Grid mode.



To move a region or regions:

= Click the Grabber, or type the letter c to activate the Grabber.

= Click and hold the mouse button on a region and drag left or right. You will see a dashed
outline of the selected region(s) moving as you drag.

L e =

Moving a selected region

= When the region is in the desired position, release the mouse button. The selected
region(s) will be moved to the new location.

= If you want to move several regions at once, Shift-click them to select them and then
move them together.

If you don’t like the result, the move can be undone with the Undo command in the Edit menu.

When Grid mode is enabled, command-left arrow moves the selected region to the left by the
current Grid value and relative to the region’s current position, and command-right arrow
moves the selected region to the right by the current Grid value and relative to the region’s
current position.

You can also use the Numeric Entry Editing to move your grabbed region. If you type values in
numeric entry fields at the top of the screen, you can move the region accordingly:
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= The Slash key (/) on your Macintosh keyboard takes you into and toggles through
numeric entry fields, and the Escape key (ESC) exits out of numeric entry fields. A red
outline around a field indicates the current active field for numeric editing. After you
type in a number, press the Enter or Return key on your keyboard and Session will adjust
the selection according to the values you have entered.

= |f the Numeric Editing Mode button is set to Move mode, you can select a region and
move the region’s beginning or end point to the value you enter in the Start or End nu-
meric entry fields. (Pressing the asterisk key (*) on the key pad section of the keyboard
will toggle between Move mode and Trim mode.)

= |f the Numeric Editing Mode button is set to either Move or Trim mode, you can move

the region by entering a location for the region’s Sync point in the Sync numeric entry
field.

= |f you precede the number you are typing in any of these numeric fields with a plus or
minus, it will add or subtract from the selection. For example, if you type +250 (Enter) it
will add 250 to the value in the selected field.

NOTE: Pressing the Enter key will drop a location Marker if you are NOT editing a numeric field.
So make sure you are in numeric editing mode before pressing the Enter key.

Moving Regions in Front or Back of Other Regions

Because Session treats regions as if they were objects, you will often find regions overlapping
each other. In fact it’s even possible for a region to become “buried” underneath several other
regions. Whatever region is on top of the pile will be heard as that portion of the track plays. If

you want to hear a part of a region which is hidden behind another region, you’ll need to move
it to the front, or move the other region to the back.

To move a region behind other regions

= With the Grabber, select the region.
« From the Edit menu choose the Send to Back commmand.



The selected region is moved to the back. The selected region is now partially obscured by the
second region. The process can be reversed by using the Bring to Front command.

To move a region in front of other regions:

= With the Grabber, select the region.

= From the Edit menu, choose the Bring to Front command. The selected region is moved to
the front.

If one region is longer than another, it’s possible for a shorter region to be completely hidden if it
is moved behind a longer one. If this happens, the only way to reveal the “buried” region it is to
select and Move to Back (or delete) the longer region. Remember, you can’t hear any part of a
region that you can’t see.

Resizing Regions

The length of a region can be changed at any time. When you resize a region, you are actually
exposing or covering up additional audio from the original sound file at the beginning or end of
the region—don't worry, you are not erasing anything..

To resize a region:

= With the Grabber, select the region(s) you want to resize. You can resize more than one
region at a time by Shift-selecting multiple regions.

= Hold the Grabber over the start or end point of one of the selected regions, and the
Grabber will turn into a left/right arrow.

= Click and hold the region start or end point. (Select the start point on the left if you want
to change the region’s beginning, and the end point on the right to change the region’s
end.)

91



92

= Drag the mouse. You’ll see the length of the region change as you drag.

ms kick

Resizing a region

= Release the mouse button and the region(s) will be re-sized. If you’re unhappy with the
results, you can undo this command by selecting Undo from the Edit menu.

You can also use the Numeric Entry Editing to re-size your grabbed region. If you type values in
numeric editing fields at the top of the screen, you can re-size the region accordingly:

= The Slash key (/) on your Macintosh keyboard takes you into and toggles through
numeric entry fields, and the Escape key (ESC) exits out of numeric entry fields. A red
outline around a field indicates the current active field for numeric editing. After you
type in a number, press the Enter or Return key on your keyboard and Session will adjust
the selection according to the values you have entered.

==

= |f the Numeric Editing Mode button is set to Trim mode you can adjust only the
start or end time of the region based on the values that you enter in the Start or End nu-
meric editing fields. (Pressing the asterisk key (*) on the key pad section of the keyboard
will toggle between Move mode and Trim mode.)

= |f the Numeric Editing Mode button is set to either Trim mode or Move mode, you can
extend the end of the region and leave the start of the region the same by entering the
desired region length in the Duration numeric entry field.

= If you precede the number you are typing in any of these numeric fields with a plus or
minus, it will add or subtract from the selection. For example, if you type +250 (Enter) it
will add 250 to the value in the selected field.



NOTE: In Trim mode typing a value or subtracting to a value in the End field that is earlier than
the Start field will delete the selected region from the track. Similarly, in Trim mode subtracting a
value in the Duration field that is less than the current duration of the selection region will delete
that region from the track.

NOTE: Pressing the Enter key will drop a location Marker if you are NOT editing a numeric field.
So make sure you are in numeric editing mode before pressing the Enter key.

IMPORTANT
You can resize a region at any time. However, if the region you resize is used elsewhere in the
session, a new region will automatically be created to avoid unintended changes from appearing
in other parts of your session. These automatically created regions take the name of the original
region and add a number to the end to keep them unique.

NOTE: If you want to silence a small portion of one placement of a particular region, but don’t
want to create an entirely new region, just lay the special region called Silence over the part you
want to mute. This keeps the number of unnecessary regions in the Audio Regions List down, and
will make the other regions easier to find.

Using the Silence Region

There will be some situations in which you wish to remove unwanted portions of a sound file.
You might decide an instrument should not play in a particular section, or there could be extra-
neous noise or hum before or after the performance. While Session can’t destructively remove or
silence a specific section of a sound file, you can still silence the undesired segment of sound in
the session by using the Silence region.
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To place a Silence region in a playlist:

= Click the Silence region in the Audio Regions List and drag it onto the portion of the
track you wish to mute.

= Using the region resizing techniques described previously, adjust the length of the Si-
lence region to mask only the undesired sound.

® Silence @ l

R

T — —

Placing the Silence region in a track

Session provides an even more convenient way of creating Silence regions of a specific duration.
This technique utilizes the Make New Silence Region(s) command.

To Make a Silence region of a specific duration:

= With the Selector, select the portion of the track(s) that you wish to silence.

R —
——

Make a selection on one or more tracks to create Silence




= From the Edit menu, choose the Make New Silence Region(s) command (Option-Com-
mand-r). Session creates a new Silence region of exactly the same duration as your selec-
tion. The new Silence region appears in the track on top of your original selection.

A
——

Choose the Make New Silence Region(s) command
to create Silence of exactly the length of your selection

[

There are two things about the Silence region that differentiate it from all other regions. First, it’s
always available in the Audio Regions List. The second difference is, when you adjust the length of
the Silence region, Session doesn’t create a new version of the region as it would if you re-sized other
existing regions. So, you can create silences of any length without creating additional regions in your
Audio Regions List. The Silence region can be deleted, moved and re-sized in a track in the same way
a normal region can.

IMPORTANT
If you’re placing the Silence region over a noisy passage, a word of advice: Make sure that you
place the beginning of the Silence region at a point where the amplitude of the waveform you are
covering tapers down to meet the zero-crossing line (the center line of your track’s waveform
display). If you don’t do this, and the Silence region begins at a point of high amplitude in the
region it covers, you’ll hear an unpleasant click during the transition. Zoom in very closely if
you’re trying to make a precise edit with the Silence region.
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Grid Mode And Its Effect on Region Editing

Session’s Grid Mode provides you with an effective tool for quick and accurate selection of
waveforms, and alignment of regions in tracks. When Grid Mode is on, the Selector will “snap
to” the currently selected grid mode value, and regions placed in the Edit window will also line
up with the selected value. If you’ve worked with MIDI sequencers before, you can think of
Grid mode as being akin to the quantizing of note start times. However, there is an important
difference—exact alignment of region start points doesn’t guarantee that the audio within those
regions will line up on the beat, since the sound within a region doesn’t necessarily start at the
beginning of the region.

To help in accurate alignment of regions, Grid Mode provides three types of external alignment
references: time scales, Bars & Beats, and the beginning and end of other regions. These external
references create invisible “snap points” which the start points of regions are attracted to.

Changing Grid Modes
The current Grid mode is displayed in the tool bar in the Edit window. The default mode is Off.

The Grid has four primary modes of operation. They are:

1. Off, where Grid mode is turned off.

2. Time scales, including SMPTE, Feet & Frames (for film applications), and Time Line,
which allow for “spotting” regions to a time-base reference such as SMPTE.

3. Rhythmic divisions, including Beat Markers, Bars, 1/4, 8th, 16th, 32nd & 64th notes, which
provide easy alignment to a user-defined Bars and Beats reference.

4. Grid to Edits which aligns regions to the beginning and ending edges of regions on all
tracks.



Creating Crossfades Between Regions

Though Session’s digital editing tools give you the means to create extremely precise edits, there
are still times when transitions between regions may require some smoothing. For this reason,
Session provides a Fades command which allows you to crossfade between two adjacent audio
regions. Crossfade duration, position, and shape are all user-selectable, allowing you to tailor
the crossfade to your exact needs. There are 25 different Fade In and Fade Out shapes each to
choose from, providing a total of 625 possible crossfade combinations.

When you create a crossfade with this command, Session computes the crossfade and writes it
to disk. The crossfade document appears in a folder named Fade Files within the session folder.
When you play back your track, Session reads the crossfade file from disk. Fade durations can
be as long as you want.

A variety of Fade In and Fade Out curves can be selected in the Fades dialog:

Fade Length Indicator

Fade Out Beginning Point Fade In End Point

Fade Out Curve

Fade In Beginning Point Fade Out End Point

Fade Out Shape Indicator
Fade Out Start Indicator

Fade Out Finish Indicator
Fade Out Duration Indicator

Fade In Shape Indicator
Fade In Start Indicator
Fade In Finish Indicator
Fade In Duration Indicator

Fade Curve Selector

The Fades dialog 97



Different shaped curves can be assigned to the Fade In and Fade Out portions of the crossfade
by click-dragging the Fade In and Fade Out curves into the desired shapes. The Beginning and
End times for each Fade portion can also be assigned by click-dragging the Beginning and End
Points of a Fade curve. The numeric reference fields in the Fades dialog show the overall length
of the Fade, as well as individual Shape, Start and Finish Times, and Duration for both Fade In
and Fade Out portions of the crossfade. These Fade curves then control the amplitude of the
regions as they are faded in or out. By examining the shape of a curve, you can see how the
amplitude of a selected region will change during the course of the crossfade.

The following diagram will help you understand how combinations of these curves will affect
the overall shape of your crossfade. By superimposing the Fade Out curve of region 1 over the
Fade In curve of region 2, you will have a good idea of how the amplitude of each region will be
affected during the crossfade.

Splice Point

Fade In Curve H Fade Out Curve

Crossfade Section

Anatomy of a Crossfade

On the following pages are brief descriptions of some of the Fade Out and Fade In curves you
may use in your session:



Examples of Fade Out Shapes

This curve keeps region 1 at full volume throughout the crossfade and then immediately drops
the volume at the very end of the crossfade.

This curve fades out region 1 relatively slowly.

This curve fades out region 1 slightly faster.

This curve fades out region 1 with a linear fade curve. It creates a smooth, even fade out. It is the
default curve.

This curve fades out region 1 quickly at the beginning of the crossfade.

This curve drops the amplitude of region 1 even more quickly at the beginning of the crossfade.
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This curve silences region 1 at the beginning of the crossfade.

Examples of Fade In Shapes

This curve brings up region 2 at full volume immediately at the beginning of the crossfade and
keeps it there throughout the crossfade.

This curve fades in region 2 quickly in the beginning, reaching full amplitude fairly early in the
crossfade.

This curve fades in region 2 moderately fast.

This curve fades in region 2 with a linear fade curve. It creates a smooth, even fade in. It is the
default curve.
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This curve fades in region 1 slowly at the beginning of the crossfade.

This curve fades in region 2 even slower than the previous curve.

This curve silences region 2 until the end of the crossfade.

Some Useful Curve Combinations:

Here are some combinations of Fade Out and Fade In curves that you may wish to try. Some
may be more useful than others. Please experiment with other curve combinations and selection
types, too.

Linear Crossfade. A good general purpose crossfade with a smooth, even transition between
region 1 and region 2.

Equal Power crossfade. A good general purpose crossfade useful in cases where a linear cross-
fade seems to create a noticeable drop in volume across the splice point.
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Overlap Fade. This combination of curves keeps both regions at full amplitude throughout the
crossfade: region 2 “jumps in” at the beginning and region 1 “jumps out” at the end.

Silence. Choosing these two curves will create silence for the duration of the crossfade.

To create a Crossfade between two regions:

= With the Selector, click at the point where you want the crossfade to begin in the first
region, and drag the mouse to where you want it to end in the second region. The two
regions must overlap edges or touch in order for Session to generate the crossfade. (How-
ever, one of the regions must not extend beyond both ends of the region above, or else the
Fades command will not be selectable in the Edit menu.)

Guitar

Selecting across the boundaries of two adjacent regions to create a crossfade

= A variety of selection types are possible. Crossfades selections can be perfectly centered
around the borders of the two regions or longer in one region than another. Don’t be
afraid to experiment to get the exact effect you want.

= Release the mouse button.
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= From the Edit menu, choose the Fades command (Shift-Command-F). The Fades dialog
appears prompting you to choose your Fade Out and Fade In curves.

= In the Curve Editing box, selecting In Only allows you to choose only the Fade In curve,
selecting Out Only in the Curve Editing field choose you to edit only the Fade Out curve,
and selecting Both allows you to choose both Fade In and Out curves in tandem. Select
the Curve Editing mode you wish to use.

= Click and drag the Fade In/Out curve(s) to the desired shape.

Selecting a Fade Curve

= |f you wish to change the Beginning and End times for the Fade In or Fade Out curves of
your crossfade, click and drag the Beginning and End Points of a Fade curve to the de-
sired beginning or end time. You can create a crossfade where one of the Fade portions
reacts earlier than the other to its chosen curve.
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Click and drag the beginning (or end) point of a Fade curve

; ", Fade Time Indicator updates
-~ beginning (or end) point position

Dragging the Beginning or End Point of a Fade Curve
The numeric reference fields in the Fades dialog indicate the overall length of the Fade, as well
as individual Shape, Start and Finish Times, and Duration for the Fade In and Fade Out portions
of the crossfade.

= Click OK to close this dialog.

Session will calculate the crossfade and write it to disk. Crossfades appear in their own Fades
Folder within the session folder.

| poofieeen

After Session generates the crossfade, it looks like this




After you have created a crossfade, it is still possible to edit its length by selecting the Fade
region with the Grabber and dragging its beginning or end point to shorten or lengthen the
crossfade length. Double-clicking the Fade region with the Grabber reopens the Fade dialog,
allowing you to reedit the Fade curves, if desired.

To remove a crossfade:

« Choose Undo from the Edit menu.
OR:

= Select the crossfade with the Grabber and press the Delete key. The crossfade is re-
moved.

Creating Fade Ins/Outs

In addition to allowing you to crossfade between two regions, the Fades command also lets you
create a fade in or fade out at the beginning or end of a region by fading from the exact begin-
ning of the region, fading from a Silence region, or fading from a blank area in a track. The
length of your selection in the region will determine the length of the fade in/out.

To Create a Fade In:
= Select the beginning of the region(s) that you wish to fade in. The selection must start

from the exact beginning of the region, or begin from a Silence region or a blank area in
the track.
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USER TIP: Option-Shift-Tab selects audio from a cursor positioned within a region to the beginning
of the region. Shift-Tab selects audio from a cursor positioned within a region to the end of the
region.

To create a Fade in, the region must be preceded by a blank area, a Silence region,
or the Fade In selection must begin precisely at the beginning of the region

= From the Edit menu, choose Fades. The Fades dialog appears prompting you to choose
your Fade In curve.

The Fades dialog when creating a Fade In

= Click and drag the Fade In curve to the desired shape.
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= Release the mouse, and click OK. The chosen fade curve will appear in the region.

To Create a Fade Out:

= Select the end of the region or regions that you wish to fade out. The selection must extend
to the exact end of the region, or extend to a Silence region or a blank area in the track.

Giuitar

To create a Fade out, the region must be followed by a blank area, a Silence region,
or the Fade out selection must extend precisely to the end of the region

= From the Edit menu, choose Fades. The Fades dialog appears prompting you to choose
your Fade Out curve.

The Fades dialog when creating a Fade Out
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= Click and drag the Fade Out curve to the desired shape
= Release the mouse, and click OK. The chosen fade curve will appear in the region.

After you have used the Fades command to create a Fade In/Out, you can still edit the length of
the fade by selecting it with the Grabber and resizing its length. Double-clicking the Fade region
with the Grabber reopens the Fade dialog, allowing you to reedit the Fade curve, if desired.

NOTE: Though fades may appear to be discrete regions they cannot actually be separated from the
region(s) in which they were created.

Using Markers

Session’s Markers allow you to define a given location in a track or region as a Marker and then
quickly navigate to that point by selecting one of the Transport’s location Markers.

Markers can be “dropped on the fly” during playback, or created while editing in conjunction
with the Transport. Markers are visible in tracks, so if you select one of the location Markers on
the Transport, a blue triangle will appear in the Time Line along with the Marker’s name and a blue
line extending across the tracks, indicating the Marker’s position.

To create a Marker during playback:

= From the Display menu, choose Markers. A check next to this item indicates that it is
chosen.

= As your session plays back, press the Enter key on the Macintosh keyboard. A Marker
will be “dropped” at that point in the track. If there are already Markers in the file, this
method will set the next available Marker.
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A track Marker
If the Auto Name Markers command is enabled in the Options menu, Session will automatically
name your Markers successively Markerl, Marker2, Marker3, and so on. These are the default
names for the Auto Name Marker command. A check next to this item indicates that it is enabled.

If your wish to change the naming preferences for the Auto Name Marker command to something
more specific to your particular session, just do the following:

To change the Auto Name Marker preferences:

= From the Setup Menu, choose the Marker Auto Naming command. The Marker Auto
Name Setup window appears.

Marker Auto Name Setup

The Mark Auto Name Setup
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= In the Name field, type the name you would like the Auto Name Marker command to use.

Try to keep this field short, so your Markers don’t get too long and become difficult to
read in the Time Line.

= In the Number field, type the starting number used to successively number Markers.

= In the Zeros field, type the minimum number of digits to appear in Marker number. For
example, typing a “2” would mean the Marker number will show at least two digits, so
then the first Marker dropped will read Marker0O1.

= In the Suffix field, type any additional information you wish to append to the Marker.
Remember to keep this field short, so your Markers don’t get too long and become diffi-
cult to read in the Time Line.

= Click OK to close this dialog.

The next time you create a new Marker with the Auto Name Marker command enabled in the
Options menu, the Marker will bear the Marker Auto Naming preferences you just defined. All
Markers created before the changed preferences will keep the same names, and you can change
the preferences again at any time to create different named series of Markers.

i:u:u 0z 352 i:u:u R
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A track Marker from a customized Auto Name Marker Setup

If the Auto Name Markers command is not enabled in the Options menu, a Marker dialog box
will appear. Type the desired name for the Marker, and click OK to close the dialog.
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2nd Choru

Naming a Marker
To create a Marker when playback is stopped:

= From the Display menu, choose Markers. A check next to this item indicates that it is
chosen.

« Go to the desired location in a track and click with the Selector.
= Press the Enter key on the Macintosh keyboard.
OR:

= On the Transport, click and hold down the Current Marker pop-up. Select Name... and
release the mouse. (Click the box in the upper right-hand corner of the Transport window
to display the entirety of the window, if needed.)

Ferome...

Delate.

sSession Start 00:00. 000 [arket 1
Harker1 oo:02.551

Harkerz 00:05. 740

Session End 00:28. 468

The Current Marker pop-up menu in the Transport

= A Marker will be “dropped” at that point in the track.
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To go to a Marker:

= From the Display menu, choose Markers. A check next to this item indicates that it is
chosen.

= On the Transport, click and hold down the Current Marker pop-up. Select the desired
Marker location and release the mouse. (Click the box in the upper right-hand corner of
the Transport window to display the entirety of the window, if needed.)

Delete:

Session Start

|oﬂurher1 ;2 - 00:00:07:13

(003400
Session End 00:05:22:02

Selecting a Marker in the Current Marker pop-up

= The screen will scroll to the selected Marker location. Press the Play button on the Trans-
port, and playback will begin at the Marker location.

OR:

= |f the Marker is visible in the Time Line, hold down the Command key and Click the
Marker. (Choose the Markers command from the Display menu to show Markers in the
Time Line. A check next to this item indicates that it is chosen.)

= Press the Play button on the Transport, and playback will begin at the Marker location.
Here are some other handy key commands to help you navigate around the session:

= Option-left arrow or Page Up key takes you to the previous Marker in the session.

= Option-right arrow, Page Down key takes you to the next Marker in the session.

= Option-up arrow or Home key or Return key takes you to the beginning of the session.
= Option-down arrow or End key takes you to the end of the session.

112



NOTE: Shift-clicking on a Marker will extend the current selection to that Marker.

To move a Marker:

= From the Display menu, choose Markers. A check next to this item indicates that it is
chosen.

< In the Time Line, click and drag the Marker to the desired location.
= Release the Mouse. The Marker is moved.
OR:

= In the Time Line, double-click the Marker that you wish to move. A Marker dialog box will
appear:

Typing a new location in the Marker dialog

= Click with the mouse on the Location field, and the outline of the field will turn red. Enter
the desired time for the Marker on the key pad of your Macintosh keyboard. This method
of moving a Marker allows for accuracy down to a specific frame.

= Click OK to close this dialog. The Marker is moved.

To rename a Marker:

= From the Display menu, choose Markers. A check next to this item indicates that it is
chosen.
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= In the Time Line, double-click the Marker that you wish to rename. A Marker dialog box
will appear.

= Type the new name you wish to give to the Marker.
= Click OK to close this dialog. The Marker is renamed.
OR:

= On the Transport, click and hold down the Current Marker pop-up. Select the desired
Marker you wish to rename and release the mouse.

= Click and hold down the Marker pop-up once again. Select Rename... and release the
mouse. A Marker dialog box will appear.

= Type the new name you wish to give to the Marker.
= Click OK to close this dialog. The Marker is renamed.

To delete a Marker:
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= From the Display menu, choose Markers. A check next to this item indicates that it is
chosen.

= In the Time Line, Option-Click the Marker. The Marker is erased.
OR:

= On the Transport, click and hold down the Current Marker pop-up. Select the desired
Marker you wish to delete and release the mouse.

= Click and hold down the Marker pop-up once again. Select Delete... and release the
mouse. The Marker is erased.



QuickTime

QuickTime Requirements

In order to take advantage of Session’s QuickTime capabilities you will need the following
hardware and software:

= Version 2.0 or higher of Apple’s QuickTime system extension (included with your Ses-
sion system). If QuickTime is not installed, run the Custom Install from your Session
installation disks to install QuickTime. If QuickTime is not installed upon launching
Session, a dialog will inform you that all movie functions will be disabled.

= Apple’s QuickTime PowerPlug system extension, if you are running Session on a
Macintosh PowerPC computer.

« QuickTime movie playback and editing software (e.g. Adobe Premiere™, AVID
VideoShop™, Macromind Director™, or Apple MoviePlayer™).

Optionally, you may also want:

= QuickTime movie capturing hardware and software to digitize your own movies from a
videotape or video camera source.

= An Apple CD-ROM drive running at 2x speed or faster to take advantage of commer-
cially available QuickTime movies and sound clips.

= Apple’s CD-ROM software package (included in Apple’s System Software 7.5 installa-
tion disks and with most commercial CD-ROM drive packages).
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Importing QuickTime Movies

In this section you’ll learn how to import a QuickTime movie into your session.
To import a QuickTime movie into Session:

= Launch Session and create a new session, or open an existing one.

= Check the time code parameters of the session to make sure they match those of the
soon-to-be-imported movie and save the session.

= Choose Import Movie from the Movie menu. The Import Movie dialog appears:

Thsprmmpl wrarid mepg NTH
aThe Oreaming 895 | Baiktop |

=] Show Previem

The Import Movie dialog

= Use the directory pop-up menu to locate the desired movie.

When you select a movie in the Import Movie dialog, you can view a preview frame using the
Show Preview check box. The “preview” is always the first frame of the movie. If you have not

yet created a preview, you can do so by first selecting the movie and then clicking Create in the
Import Movie dialog.

= After locating the movie you want to import, make sure it is selected (highlighted) and
click Open.

Session will display the movie in its own Movie window, and first frame of the movie will be
synchronized to the start time of your session. Here’s an example of a session with an imported
QuickTime movie displayed the Movie window:
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Session after a Movie has been imported, showing the Movie window

If you don’t see your Movie window or if it’s hidden behind another window, choose the Movie
command from the Display menu (Command-m) to bring the movie window to the front of your
screen. Once a QuickTime movie has been imported into a session, the movie is displayed in a
floating Movie window, described in greater detail in the next section.

You can have only one QuickTime movie associated with each session. If you wish to import
another movie into the session, the new movie will simply replace the original in the session.
Although the original movie is released from the session, it remains on your hard disk in case
you want to re-import it into your session or another session later on. To import another movie
into the session, repeat the steps described above.
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The Movie Window

The Movie window is your movie “screen.” It displays the movie playback or the current frame
if playback is paused or stopped. You can center or drag the Movie window anywhere on your
computer screen (or screens) and you can resize the Movie window to half or double its initial
size at the time of the movie import. You can also enable the Movie window to “float” in the
forefront of the screen, allowing the Movie window to remain in constant view even as you call
forth and edit in other Session windows. However you configure the Movie window, its current
state will be remembered by the session the next time you open it. The Movie window can be
shown/hidden via the Movie command from the Display menu.

The Movie window, paused on the first frame of the movie.
To display the Movie window:
= From the Movie menu, choose the Movie command. Assuming a movie has been imported

already, the Movie window will open. If the Movie window was hidden behind another
window, choosing the Movie command will bring it to the front.

To resize the Movie window:
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= From the Movie menu, choose one of Half Size, Normal Size, or Double Size commands.
The Normal Size setting is the default size for the imported movie, and it provides the
smoothest playback quality.

NOTE: If you wish to further resize the dimensions of the Movie window or modify it in any way,
you must return to your video capture/playback environment (e.. Adobe Premiere) to make the
changes, re-save the movie file and re-import it into Session.

To center the Movie window on-screen:

= From the Movie menu, choose the Center Movie Window command. The Movie window
will center itself on-screen, and Session will remember its location the next time you
launch your session.

To move the Movie window anywhere on-screen or to a different screen:

= Click and hold down the mouse on the Grabber Bar along the top edge of the Movie
window.

The Grabber Bar along the top edge of the Movie window

= Drag the Movie window anywhere on-screen or to a different screen.
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= Release the mouse when you have moved the Movie window to the desired location. Its
location will be remembered the next time you launch your session.

Floating the Movie Window

As long as the Movie Window Floats command from the Movie menu is enabled, the Movie win-
dow will remain in constant view even when you call forth the Edit window. Generally you’ll
want to leave this command enabled as long as you’re editing to picture. If this command is
disabled and you click the mouse anywhere on a track, the Movie window will drop back be-
hind the Edit window.

To float the Movie window:

« From the Movie menu, choose the Movie Window Floats command. The Movie window
will float in the forefront of the screen. The Movie window will remain in constant view
even when you call forth the Edit window. A check next to this menu item indicates that
the command is enabled.

To “un-float” the Movie window:

< From the Movie menu, choose the Movie Window Floats command again to disable it. The
Movie window will no longer float and will move to the back when the Edit window is
called forth. The absence of a check next to this menu item indicates that the command is

disabled.
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Mixing

Grouping Faders and Pans

Before cover creating level and pan automation, it’s important that you know about Session’s
ability to group gain and pan faders. There are many instances in a mixing situation where you
need to move several faders at once. For instance, you might wish to control a pair of tracks with
instruments or vocals recorded in stereo. It’s important to keep such tracks at the same relative
level to preserve their stereo balance. If you’re using an external MIDI control surface, this is
easy enough to do, but if you’re not, you’re limited to mouse control. With a single mouse, this
presents a problem, since your mouse can only move one fader at a time.

Fortunately, Session provides you with a way to link two or more faders and move them as a
group. You can create up to four different groups. A simple group could contain a pair of gain
faders. A more complex group could include pan controls for several channels, or a collection of
several faders to control all of the parts of a drum “submix.”

To assign gain or pan faders to a group:

< Hold down the Shift key and click on the fader that you wish to group. The Group pop-
up menu appears.

121



Assigning a gain fader to a group

= Select the group (1-4) that you wish to assign to controller to.
= Release the mouse button. The fader is now included in the group that you selected.

= To add other faders to the group, hold down the Shift key and click on another fader that
you wish to group. When the Group pop-up menu appears, add this fader to the same

group.
= Repeat this process as many times as required to add all of the faders you wish to in-
clude in the same group.

Repeat this process as many times as you wish to create up to four different groups. Once
you’ve assigned your group(s), moving any faders within the group will automatically move all
faders assigned to that group proportionally.

At times, you will probably want to adjust the level of a grouped controller without affecting the
other controllers in the group. This is easy to do.

To move a grouped controller individually:

< Hold down the Command key.

= Click a fader or knob and drag it to a new level. Note that the other faders in the group
do not move.

122



= Release the Command key.
The fader will now maintain its new position relative to the other controllers in the group.

To remove a controller from a group:

= Hold down the Shift key and click on the fader that you wish to ungroup. The Group
pop-up menu appears.

— .
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Ungrouping a fader

= Select None and release the mouse button. The fader is removed from the group.

Using Digital Equalization

Session provides you with two digital equalizers (EQs) per track for enhancing the sonic charac-
ter of your mix. If you use EQ properly and in moderation, your mixes can be made “punchier,”
and instruments and vocals can be brought out of the depths of a mix and given more of an
edge. On the other hand, if you overuse EQ or use it improperly, your mix can become dis-
torted.
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In general, good use of EQ is more about taking away than it is about adding. While a novice
producer will often concentrate only on using EQ to boost things, the more experienced producer
will focus on using EQ to cut—finding frequencies that interfere with the mix and removing
them. In reality, judicious use of both cutting and boosting will allow you to achieve the ulti-
mate goal: giving your mix clarity by carving out different frequency ranges for each instrument in your
mix.

A word to the wise: Human ears are very sensitive to the range between 1kHz and 5kHz. The
reason for this is simple: this is the range where human speech falls, thus our ears are naturally
tuned to this range. If you want something to really stand out in a mix, put it in this range.
However, don’t bunch everything up in this range or your mix will sound claustrophobic!

Ideally, if you’ve been careful in the recording stages of your project, your tracks will need very
little EQ at all. If you’ve used good microphones and paid extra attention to the sound of your
instruments before committing them to disk, you won’t have to resort to “fixing things in the
mix.” The best rule of thumb is this: use your EQs when and where you really need to. They’re
great for solving problems or adding a little extra zing to a mix, but in the end, a little extra care
during recording is always preferable to fixing things later.

Types of EQ

Session provides five types of EQs. Each EQ has controls for selecting the EQ Type, Gain (the
amount the frequencies are cut or boosted), Frequency (the specific frequency to be cut or
boosted), and a Bypass button for disabling the EQ. In the case of the parametric EQ, an EQ
Bandwidth selector is also included (for choosing how wide a range of frequencies will be af-
fected).

= A Low-Shelf EQ boosts or cuts frequencies at or below the selected frequency setting.

= A High-Shelf EQ boosts or cuts frequencies at or above the selected frequency setting.

= A Parametric EQ boosts or cuts only those frequencies centered around the selected
frequency setting. A pop-up menu allows you to select the width (from 1/3 to 3 octaves)
of the parametric EQ. This determines the width of the filter’s overall slope—from a
broad “bell”” shape to a narrow “notch.”



= A High Pass EQ filters out frequencies below the selected frequency setting while allow-
ing all others above to pass through.

= A Low Pass EQ filters out frequencies above the selected frequency setting while allowing
all others below to pass through.

Auditioning an EQ

The best way to audition the effect of an EQ is to increase its gain and then drag its frequency up
or down until you hear its effect. Then go back and make more precise adjustments the EQ’s
gain (and width, for the Parametric EQ). Remember that some instruments occupy only a very
small frequency range, so you may need to fine tune the EQ’s frequency range to hear its effect
on your track. Don’t switch EQ types while you are recording or playing audio or you may get

unpleasant pop and clicks. You can use two EQs on a track if you wish to achieve a more spe-
cialized tonal effect.

- Only
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Click on a track’s EQ button to make the EQ editor appear.
Click on a track’s EQ LED to enable (or disable) the EQ.

+11.0 dE| —l]n

Clicking an EQ button makes the EQ editor
appear (Parametric EQ is currently selected)
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Choosing an EQ type from the EQ Type pop-up menu

To apply EQ to a track:

* Open the Mix window by pressing Command-M.

= Click the green EQ LED on the desired to track to enable the EQ. When the LED is lit, it
indicates that the EQ is on.

= Click the white EQ button to open the EQ Editor.
= From the pop-up menu, select the EQ type that you wish to use.
= Click Play on the Transport to begin audio playback.

= Adjust the parameters of the EQ you have chosen to achieve the desired result. By click-
ing the Bypass button you can compare the sound of the track with and without EQ.

= Repeat as necessary if you wish to add a second EQ to a track.

To disable EQ on a track:

= Click the green EQ LED (either 1 or 2, depending on which you wish to disable) on the
desired track. When the LED is dimmed, it indicates that the EQ is off.

Session EQs are for playback only and are nondestructive. Currently, Session does not allow you
to add EQ to a signal input, to record the effect of your EQ onto the take.
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Recording and Editing Mix Automation

Automated mixing technology has become a standard feature of many professional recording
systems. Automation greatly enhances the mixdown process by allowing you to perform your
mix in real time—including fader movements, panning, and so on—while recording it all, much
like a MIDI sequencer records MIDI performance data.

Session Software provides you with a means of automating your final mixdown too, by allowing
you to record and edit Gain and Pan automation using playlists, just as you learned to do with
audio. Using your mouse or an external fader controller to perform themix, you can build it up in
stages, and when it comes time to create the “master” of your final mixdown, you can be assured
of having exactly the same mix every time. In addition, you have access to Session’s editing func-
tions, making Session’s automation an extremely powerful tool for creating a polished final
mixdown.

Gain and Pan Automation Are Independent

Because Session treats Gain and Pan automation separately, they can be both recorded and
edited separately. Thus, recording an automation pass in which you move only Pan sliders will
not record over any Gain automation, or vice-versa. In addition, if you record Gain automation
for a track that has been grouped to other tracks, the automation data will be recorded to all
tracks in that group.

To record fader automation on a track:

= Click the automation record-enable button (the A button) on the track that you wish to
automate. The button turns red, indicating that automation is record-enabled.

= A dialog appears prompting you to name a playlist for recording automation.
= Enter a name for the automation playlist and click OK.

= When you’re ready to begin, click Play or press the Space bar. (It isn’t necessary to press
Record to initiate automation recording.)
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= Automation recording begins. Move the faders as you wish. When you’ve finished, click
Stop or press the Space bar again.

To listen to your automation:

= Turn off automation record-enable (the A button) so that you don’t accidentally record
over your previous pass! This is very important since you can record automation with

just Playback engaged. (Remember, it isn’t necessary to press Record to initiate automation
recording.)

= Click Return to Zero and then Play on the Transport to listen to your automation.

= If you like what you’ve recorded, make sure to save it by choosing the Save Session com-
mand in the File menu.

= Follow the same procedure to record additional automation. Remember, recording an

automation pass in which you move only Pan sliders will not record over any Gain auto-
mation, or vice-versa.

Automation appears as “breakpoint” lines. One line represents
Gain automation (in red). The other represents Pan automation (in blue)

Automation data can be edited in much the same way audio can. However, to edit this data, you
must go to the Edit window and use the Gain Automation and Pan Automation commands (in the
Display menu) to view the track’s Gain and/or Pan automation. For more information about
editing automation, see the section that follows this.
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IMPORTANT
On slower models of Macintosh computers, Session’s faders may appear to move in a sluggish
or “chunky” manner during playback and recording. If the faders seem to jump from position to
position don’t worry. This occurs because Session’s audio tasks take precedence over the screen
display. This sluggish movement doesn’t affect mix automation and it is not reflected in the
audio playback. If you find this distracting, you may wish to turn off the Moving Faders option
(in the Options menu). This will also improve Session performance.

Creating Different Versions of Your Mix with Automation Playlists

Because Session’s Automation tracks utilize playlists, you can create several different versions of
your mix by recording different automation on different playlists. This is as simple as creating a
new playlist and performing new automation. Once you have created several different versions
of your mix, you can select the best one from among these playlists.

To create a new automation playlist:

= Click the Automation Playlist pop-up on the desired track and select New.

Renarne... %
Lrelete

Creating a new automation playlist

= A dialog appears prompting you to name the new playlist. Enter a name and click OK.
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= Record the new automation pass as desired.

= Later, if you wish to switch to a different playlist, click the Playlist pop-up and choose
the one you desire.

Copying Automation from One Playlist to Another

It’s often useful to have the same automation on more than one track. This is particularly useful
in the case of instruments recorded in stereo, where it’s good to keep gain automation the same
between the right and left channels of the stereo signal.

To copy automation from one playlist to another:
= On the track you wish to copy the playlist from, choose Copy from the Playlist Selector

pop-up. Session copies the playlist that is currently active on this track and adds it to the
list of playlists, appending the word “copy” to its name.

The Copy command copies the currently active playlist

= On the track you wish to copy the Playlist to, click the playlist selector pop-up and select
the copied playlist. You now have the same automation active on both tracks.
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Selecting a copied playlist

Editing Automation

No matter how skilled you are at mixing, it’s inevitable that you’ll want to fine tune your auto-
mation using Session’s editing tools. As you learned earlier, Session treats Gain and Pan auto-
mation separately. Thus they can be both recorded and edited separately. If you examine your
automation in the Edit window you will see that Session displays automation as a breakpoint-
style line graph. Gain automation is represented by a red line. Pan automation is represented by
a blue line. To edit automation, simply click on a point on the appropriate line and drag it to the
desired location. The cursor will change its appearance depending on whether you are editing
an existing automation point or creating a new one. As you move the breakpoint line, the meter
data indicator on the track will indicate changes made to gain value (in dB) or changes made to
the pan value.

= Dragging the Gain breakpoint line upwards increases gain. Dragging it downwards
decreases gain.

= Dragging the Pan breakpoint line upwards pans left. Dragging it downwards pans right.
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Automation appears as “breakpoint” lines. One line represents
Gain automation (in red) and another represents Pan automation (in blue)

As noted above, you will see the cursor change its appearance depending on whether you are
editing an existing breakpoint, creating a new breakpoint, deleting a breakpoint, or performing
any of the above functions on multiple breakpoints within a selection. Here is a visual guide to
how the cursor appears in each of these cases:

The cursor looks like this if you are
moving an existing breakpoint.

vob bl Lkl

The cursor looks like this if you are
creating a new breakpoint.



The cursor looks like this if you
are deleting a breakpoint.

The cursor looks like this if you are moving
multiple breakpoints within a selection.

To view automation data:

= Open the Edit window by pressing Command-E on your keyboard.

= To view Gain automation, choose Gain Automation from the Display menu. Gain automa-
tion is represented by the red breakpoint line.

= To view Pan automation, choose Pan Automation from the Display menu. Pan automation
is represented by the blue breakpoint line.

To hide automation data:

= To hide Gain automation, choose Gain Automation from the Display menu a second time.
= To hide Pan automation, choose Pan Automation from the Display menu a second time.
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To move an existing automation point on the breakpoint line:
= Place the cursor over the automation point you wish to move. Click on the automation
point and drag it to the desired position.
= To constrain movement up/down or right/left, hold down the Shift key while you drag.

To add a new automation point to the breakpoint line:

= Click on the breakpoint line, and without releasing the mouse button, drag the new point
to the desired position.

To move several automation points on the breakpoint line at once:

= Use the Selector to select the portion of the track containing the automation points you
wish to move. (To toggle to the Selector, press the X key on your keyboard.)

= Use the Grabber to drag any of the automation points within the selected range to the
desired position. Session moves all of the points proportionally. (To toggle to the Grab-
ber, press the C key on your keyboard.)

= |f you wish to move the selected points without affecting the slope of the breakpoint line
outside the selection, enable the Smart Breakpoints option in the Options menu. This creates
new breakpoints on both sides of the selection, preventing your edit from affecting the
breakpoint slope outside the selection range.

To move a single automation point within a selected range:
< Hold down the Command key and use the Grabber to drag the automation point within

the selected range to the desired position. As long as the Command key is depressed,
Session will allow you to select a single automation point.
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To delete an automation point:

= Hold down the Option key and click on the automation point. The automation point is
deleted.

To delete several automation points:

= Use the Selector to select the portion of the track containing the automation points you
wish to delete. (To toggle to the Selector, press the X key on your keyboard.)

= Switch to the Grabber (press the C key on your keyboard).

= Hold down the Option key and click on any of the automation points within the selected
range. Session deletes all of the points within the selection.

To delete all automation points in a track:

= Double-click the Selector in the desired track. The entire range of the track is selected.

= Hold down the Option key and click on any automation point. All automation points in
the track are deleted.
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Session Menus

The File Menu

New Session N
Open Session... #0
Close Window ®LW
Close Session =33
Save Session ®S
Save Session As... i3S
Save a Copy In... “3H#S
Add Audio File... 430
Import Audio File... =30
Bounce Tracks... {r¥#B
Delete Audio File(s)...

Calc All Waveforms ®Y
Calc Selected Waveforms {3#Y
Quit #®0

The File menu contains all of the commands you’ll use to create and maintain your audio files.
Here are brief explanations of each.

New Session

The New Session command creates a new session. When you select the New Session command, a
dialog box appears prompting you to give the new session a name. When you name the session,
Session creates a folder of the same name. Within this folder is the session file itself, and two
other folders: an Audio Files folder, and a Fade Files folder. The Audio Files folder contains all
audio recorded during the session. The Fade Files folder contains any crossfaded audio data
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generated by the session. When you record a new audio track, the track is saved as a new audio
file and automatically placed in the Audio Files folder. At any time in a session, you also have the
ability to import existing audio files (in a variety of formats) into the session, and work with
them as well.
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A new session

Open Session

The Open Session command lets you open a previously created session. When you select this
command, a file dialog appears from which you will navigate to and open the desired session.
All sound files and crossfades associated with the session will load. Only one session can be
open at a time.
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The Open Session dialog

Close Window
The Close command closes the currently active window without quitting Session.

Close Session

The Close Session command closes the current session. Because Session Software can have just
one session open at a time, you must close the current session before you can open another.
Before closing the session, Session Software will ask you if you wish to save any changes that
have not been saved.
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The Close Session dialog

Save Session

The Save Session command saves the changes you have made since the last time you saved and
writes the session in its current form over the old version. You cannot undo the Save Session
command.



Save Session As...

Session’s Save Session As... command is useful for saving a copy of the current session under a
different name, or in a different hard disk location. Because the Save Session As... command
closes the current Session and lets you keep working on the renamed copy, it is particularly
useful if you are experimenting and want to save successive stages of the Session. This way, you
can save each major step under a different name such as “Music Session 1.0”, “Music Session 1.1,
etc. By working this way, you’ll always have the option of retracing your steps should you want to
go back to an earlier version.
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The Save Session As dialog

Save a Copy In...

Use the Save a Copy In... command to save a copy of the current session under a different name
or a different hard disk location. Unlike the Save Session As... command, Save a Copy in... does not
close the original session, so subsequent edits are made to the original session. Having the
backup copy gives you the option of reverting to the earlier version.
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The Save a Copy In dialog

139



Add Audio File

This command allows you to load one or more monophonic Sound Designer Il format files into
the Audio Regions List. When you choose this command, a file dialog appears allowing you to
navigate to the desired audio file. When you’ve found the file, click on it and it will appear in
the items in current file list inside of the dialog. When you double-click on an audio file, it is
added to the items currently chosen list at the right of the dialog. When you have finished choos-
ing all of the files you wish to add, click Done and Session will find and import all of these audio
files into the Audio Regions List. The Play button at the bottom of this dialog allows you to
audition an audio file before you load it into a session.
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The Add Audio File dialog

Import Audio File

This command allows you to import audio files that are in formats other than Sound Designer 11
mono (Session’s audio file format). Supported file formats are: Sound Designer Il stereo, AIFF,
WAV and Sound Resource (SND). (If you wish to import a QuickTime-format audio file, use the
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Import Other Movie Audio command in the Movie menu.) Like the Add Audio command, the
Import Audio File command adds the imported files to the Audio Regions List from where they
can be dragged into tracks. Importing sound files in non-Sound Designer Il mono formats re-
quires both time and hard disk space because the file must be converted to Sound Designer 11
mono files. If the file to be imported is a stereo file, the left and right channels will be loaded
individually into the Audio Regions List.

When you choose this command, a file dialog appears allowing you to navigate to the desired
audio file. The File Filters pop-up at the bottom of this dialog allows you to select the types of
files Session *“sees” when you navigate on your hard drive. When you’ve found the file, double-
click on it and it will appear in the files added list inside of the dialog. When you have finished
choosing all of the files you wish to import, click Finished and Session will import all of these
audio files into the Audio Regions List.

When you click on an audio file’s name in this dialog, information appears about the sample rate of
the file. The Play button allows you to audition a file before you load it into a session.

The Sample Rate Converter Quality command affects the quality of sample rate conversion that
occurs when importing sound files not originally recorded at your session’s current sample rate.
The higher the quality of sample rate conversion that you choose, the longer Session will take to
perform the sample rate conversion. Be aware that even the “low” setting provides results that
are considerably better than the Macintoshes built-in sample rate conversion. For most applica-
tions, the “medium” setting will yield very good results. Because the “high” setting takes signifi-
cantly longer than any other setting, we recommend that you use it only in cases where the
highest fidelity is absolutely essential and you have a considerable amount of time to devote to
this process. (The high setting can take as long as several hours to process a soundfile of moder-
ate length.) Please also be aware that sample rate conversion is optimized for Power
Macintoshes. Non-Power Macs can take an extremely long time to perform this function, espe-
cially at higher quality settings.
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Bounce Tracks

The Bounce Tracks command allows you to mix together the outputs of all currently audible
tracks to create a new audio file. The new “bounced” audio file (or files if you bounce to a split
stereo file) then appears in the Audio Regions List, from where it can be dragged into a track.
When you bounce a file, you can save it as one of three file types: a Mono file, a Split Stereo file,
or an interleaved Stereo file, in either 16-bit, or 8-bit resolution. With this function, “what you
hear is what you get.” In other words, when you play back your session, all tracks that are heard
are included in the bounce. Any tracks that are muted will not appear in the bounce. If you have
made a selection in a track (or tracks) Session will bounce only the tracks in which the selection
appears, for the length of the selection. If there is no selection in any track, Session will bounce all
audible tracks for the length of the longest audible track in the session.

The Sample Rate Converter Quality command (Options menu) affects the quality of sample rate
conversion that occurs when bouncing to a sample rate other than your session’s current sample
rate. The higher the quality of sample rate conversion that you choose, the longer Session will
take to perform the sample rate conversion. Be aware that even the “low” setting provides
results that are considerably better than the Macintoshes built-in sample rate conversion. For
most applications, the “medium” setting will yield very good results. Because the “high” setting
takes significantly longer than any other setting, we recommend that you use it only in cases
where the highest fidelity is absolutely essential and you have a considerable amount of time to
devote to this process. (The high setting can take as long as several hours to process a soundfile
of moderate length.) Please also be aware that sample rate conversion is optimized for Power



Macintoshes. Non-Power Macs can take an extremely long time to perform this function, espe-
cially at higher quality settings.

The 8-bit Squeezed option in this dialog uses a proprietary DSP algorithm specifically designed
for performing 8-bit conversion. It greatly optimizes the dynamics of the audio by preprocessing
it using compression, limiting and gating before conversion to 8-bit resolution. This results in
much greater apparent loudness in the signal, improved intelligibility, and above all, avoids
problems that can typically make converted low-level signals sound “grungy.” If you are con-
verting 16-bit audio to 8-bit resolution, we recommend that you use this option for optimal
results.

The 8-bit Rounded option converts a 16-bit signal to 8-bits by rounding off the extra bits (not
truncating them). This provides approximately 3dB better signal-to-noise ratio that some other 8-
bit conversion schemes which merely truncate the extra bits. If your audio material consists of
just dialog with few or no breaks, or is very consistent in its dynamics (without wide variations
in volume), you may wish to use this option for converting to 8-bit. Otherwise, use the 8-bit
Squeezed option, explained above.

The Scaling option prevents clipping in your bounced signal. Generally you should only enable
this option if your source material is so loud that it clips your outputs during playback. If clip-
ping isn’t a problem, leave this option off for best sonic results.

The Bounce Tracks dialog 143
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Delete Audio File(s)

This command allows you to permanently erase an audio file from your hard disk. To use this
command you must first select a “whole file” region by clicking its name in the Regions List and
then choosing this command. Session will not allow you to remove a soundfile if it is being used in any
track/playlist in a session—even if the playlist is not currently loaded onto a track. Because it can be
used to permanently erase audio data from your hard disk, this command should be used with
caution! In order to delete a “whole file”” region you must first remove all sub regions created
from it in the Audio Regions List.

Calc All Waveforms

This command creates a waveform view for all sound files and regions in the current session so
that they can be viewed and edited graphically. When you record a take, it has no waveform
overview associated with it until you use this command or the Calc[Selected Waveforms command
to make Session create the waveform data for it.

Calc Selected Waveforms

Like the Calculate All Waveforms command, this command creates waveform overview data for
sound files and regions. The difference is that this command can be used to create waveform
overview data for a specific soundfile or region. To use this command, simply click on one or
more regions in a track with the Grabber and choose Calculate Selected Waveforms. Session will
then create the waveform overview data. The region can then be viewed and edited graphically.

Quit

The Quit command ends your session and returns you to the Finder. Although Session will
warn you before allowing you to quit without saving changes, it’s still a good idea to save your
work before quitting.



The Edit Menu
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The Edit menu contains all of Apple’s standard edit commands, as well as a several region editing
commands. As you remember, Session performs nondestructive editing, meaning that the commands
in this menu won’t actually alter your source files. Here are brief explanations of each command in
the Edit menu:

Undo

The Undo command is a very useful tool and something of a “safety valve.” It keeps track of
your last action and allows you to undo that action if you don’t like the outcome. After you
undo something, you can “redo” it by choosing the command again. This is a convenient way to
compare before and after states of most edits. But be aware that the Undo command only keeps
track of your last action, so use it with care—edits more than one step back cannot be undone.
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Cut

With the Cut command you can “cut” a selected region out of its current position in a track. The
Macintosh holds it on the Clipboard (the Mac’s internal memory) in case you want to paste it
elsewhere. Of course, since Session is nondestructive, you aren’t actually cutting data from the
original file, but the effect is the same.

Copy
The Copy command is much like the Cut command, but instead of removing the selected region,

it leaves the original, and makes a copy of it in the Macintosh’s Clipboard so that you can paste
it elsewhere.

Paste

With the Paste command, you can insert the contents of the Clipboard into a location that you
have chosen with the Selector. It is only possible to paste data after it has been cut or copied to
the Clipboard.

Clear

The Clear command allows you to remove a selected region from its location in a track. Of
course, since Session is nondestructive, this command doesn’t actually remove the data from the
original audio file.

Select
This command has three subcommands which allow you to make a selection of a specific type,
each of which is covered below.

Left of Current
This command selects all regions to the left of a selected region or the playback cursor’s cur-
rent location on one or more tracks.

Right of Current
This command selects all regions to the right of a selected region or the playback cursor’s
current location on one or more tracks.



All
As its name suggests, this command selects all sound files and regions in all tracks in the
session.

Trim

This command has two subcommands which allow you to trim a selection in a specific way, as
explained below. To trim a selection, you must first click the Selector at the desired location in a
track, and then select one of the following commands:

Trim Start to Cursor
This command trims the start of the region to the Selection cursor’s current location on one or
more tracks.

Trim End to Cursor
This command trims the end of the region to the Selection cursor’s current location on one or
more tracks.

Send to Back
This command moves a selected region behind any regions that it overlaps.

Bring to Front
This command moves a selected region in front of any regions that overlap it.

Make New Region(s)

This command defines a selection as a new region. The new region then appears in the Audio
Regions List, and in the track where it was defined, where it overlaps the original soundfile from
which it came. In contrast, regions created with the Separate Region command behave as if they
were “cut out” from the track: if you move the region, it will leave a hole in the track.
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Make New Silence Region(s)

This command defines a selection on one or more tracks as silence by automatically creating a
new silence region of the exact duration as the selection. To use this feature, simply make a
selection within a track with the Selector and choose Make New Silence region(s). A new silence
region then appears in the track where the selection was made. This command is very useful for
muting playback of specific portions of tracks.

Delete Region(s)

This command will remove a region from the current session. Audio will not be permanently
deleted from your hard drive, however, the region definition will be removed from the session. To
delete a region, click on its name in the Regions List and select Delete Region(s). If the region is
used anywhere in the current session (in other wordes, if it is currently in a track) Session will not
allow you to delete it. If you wish to delete a region that is currently in a track, remove the
region from the track first (select it and press the Delete key on your Mac keyboard).

Separate Region

The Separate Region command defines a selection as new region, and in the process, separates it
from adjacent data in the track where it was created. The newly created region then appears in
the track and in the Audio Regions List. If you move a separated region from its original loca-
tion, it will leave a “hole” in the track.

Duplicate

The Duplicate command copies a selection and places it immediately after the end of the original
region in a track. This provides you with a very handy way of repeating a region (to create a
drum loop, a repeating bass figure, etc.) and is faster and more convenient than copying and
pasting data to achieve the same result—particularly if you want to duplicate data on multiple
tracks.

Fades

The Fades command allows you to create a user-definable crossfade between adjacent regions or
a fade in/out of a single region. This command is useful for smoothing transitions between
regions that would otherwise sound too abrupt. Crossfade duration, position, and shape are all



user-selectable. This dialog allows you to click and drag the crossfade curves to create the shape
that you desire. You can individually adjust the start or end of the Fade In/Fade Out points by
dragging them as well. To create a crossfade, use the Selector to select across adjacent regions
and choose the Fades command. In the Fades dialog, arrange the crossfade curves as you wish,
click OK and Session will create a crossfade between the adjacent regions. To remove a cross-
fade, select it with the Grabber and press the Delete key on your Macintosh keyboard. To edit an
existing crossfade, double click it with the Grabber and the Fades editor will appear, allowing
you to adjust the crossfade curves as you desire.
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The Fades dialog

Identify Sync Point

This command allows you to identify a specific point within a region that can be used to align
the region in Session’s Grid mode. This is done by clicking the Selector at the desired location
inside the region and choosing this command. A small triangle appears in a region to indicate
the location of the Sync Point. This then becomes the point at which the region will line up on
Session’s “grid” in Grid mode.
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Delete Sync Point

This command allows you to remove a Sync Point from a region. This is done by clicking the
region with the Grabber to select it, and choosing Delete Sync Point. The Sync Point is then re-
moved from the region.

Identify Bar/Beat

This command allows you to identify and mark where beats fall in a track in order to display
time in Bars and Beats. You must identify at least two reference beats from which Session can
interpolate the Bars & Beats Time Scale. To identify a Bar and Beat, click the Selector in a track
and select Identify Bar & Beat. A dialog appears asking you to enter the Bar and Beat values for
the location that you have identified. Session then interpolates a Time Line for the rest of the
recording based on the values that you entered. By using the Selector to select a range, you can
also identify Bar and Beat values for the beginning and end of the selected range. Session sup-
ports changes in meter, too. If you wish to mark a meter change, create a new beat marker or
double-click an existing one and type in the new meter value. Session will recalculate all subse-
guent bars at the new meter. If your recording has tempo changes, you should identify several
locations in the song and create Bar & Beat markers for them so that the time line that Session
calculates will be more accurate. You can drag Bar/Beat markers in tracks to adjust their loca-
tion. In order to see Bar/Beat markers, you must choose Bars and Beats from the Display menu to
display the Time Line in this format.
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The Identify Bar/Beat dialog



Delete Bar/Beat Marker

This command allows you to remove a Bar/Beat marker in a track. To do this, click on a Bar/
Beat marker in the Time Line with the Grabber. It turns white, indicating that it is selected. Then
choose Delete Bar/Beat Marker from the Edit menu and the marker is deleted.

Set User Sync

This command allows you to select a region (or regions) and redefine its “user time stamp.”
Session software has the ability to store two time stamp values for a region: a Record Time Stamp
(the time location at which the soundfile or region was originally recorded) and a User Time
Stamp (a user-assignable time location). To stamp a user time on a region, move it to the desired
location in a track, select it with the Grabber and choose Set User Sync. The current time location
is then stamped on the region (the region’s start point). If the region is later moved, its easy to
“resync” it to the user time location by simply selecting it with the Grabber and choosing ReSync
to User Time.

ReSync to User Time

This command allows you to select a region (or regions) and move it to a time location in a track
that you earlier defined with the Set User Sync command (see above). If you select multiple
regions and choose ReSync to User Time, Session will find the region that is earliest in time
(among the ones that are currently selected), move that region to the time location that you
earlier defined time, and move the other regions relative to it.

ReSync to Record Time

This command allows you to select a region (or regions) and move it to its originally recorded
time location in a track. Because Session saves the original time stamp as part of the session, you
can recall a region’s original record time whenever you choose to do so. If you have spotted the
region to a different time and wish to move it to its original time location, simply select it with
the Grabber and choose the ReSync to Record Time command.
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The Options Menu
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This menu contains commands several Session functions that can be toggled on or off.

Pre/Post Roll Playback

Choosing this option allows you to toggle Session’s Pre/Post-Roll feature on or off. By selecting
the Pre/Post-Roll command in the Setup menu and entering a specific amount of Pre- and Post-
Roll time, you can adjust playback of a selection to begin before and last until after your selec-
tion by a chosen amount. With this feature you can audition a selection and the data just before
and after it to hear it in context.

Loop Selection

Session gives you the option of being able to continuously loop playback of a selection with the
Loop Selection command. This option will make your selection play in loop fashion until you stop
playback. This “auto loop” feature is especially useful in cases where you need to test the rhyth-
mic integrity of your selection before defining that selection as a region. If your selection seems
to maintain a consistent rhythm as it loops, it is “musical.” That is, it will probably work rhyth-
mically when placed next to other regions. If the selection seems to skip as the loop repeats, you
may wish to adjust your selection. A selection must be at least 0.5 seconds in length for the loop
function to work.



Insertion Chases Playback
When this option is enabled, Session’s cursor will automatically be placed where playback stops.
This feature is very helpful for pinpointing specific spots for editing in long regions.

Power Scroll
Enabling this command causes the screen to scroll by continuously in the Edit window as playback
progresses. The screen cursor remains centered in the display.

Page Scrolling
Enabling this command causes the screen to scroll in the Edit window each time the cursor reaches
the edge of the waveform display.

Moving Faders

Enabling this command causes Session’s on-screen faders to move if automation has been re-
corded for them. When this option is disabled, automation will still operate, but on-screens
faders won’t move. Turning this option off can help speed up screen redraws and take some of
the burden off of your computer’s processor if you are using an older model Macintosh.

Auto Name Markers

When this option is enabled, Session will give markers dropped “on the fly” default names
based on the preferences you have entered in the Marker Auto Naming dialog (Setup menu). If
you wish, You can rename Markers at your convenience later. When this option is disabled,
Session will prompt you to name Markers as they are created.

Smart Breakpoints

The Smart Breakpoints option allows you to edit a selected automation range without affecting
anything outside of that range by creating new breakpoints on both sides of the selection. The new
breakpoints on either side of the selection effectively prevent edits performed on the selected
range from affecting the breakpoint slope outside the selected range.
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View At Waveform Scale

Enabling this command helps you maximize screen redraw speed in the Edit window and
increases performance of the Page Scrolling and Power Scrolling features. It does this by zoom-
ing your view to the magnification at which Session calculated the waveform display for the tracks
in your session. By doing this, Session eliminates the need to read from hard disk in order to display
waveforms of your tracks. (Reading from disk slows screen redraw speed dramatically.) If you zoom
in any farther than the “Waveform Scale” level, Session must read data from disk in order to draw
the waveforms. In essence, this option enables you to see as much as you can and still be able to
scroll as quickly as possible.

Auto Calculate Waveforms

Enabling this command causes Session to automatically calculate waveform display data for a
soundfile when you record new audio. This saves you the trouble of manually choosing theCalc All
Waveforms or Calc Selected Waveform commands in order to see a waveform display for a newly
recorded take.

Sample Rate Converter Quality

This command allows you to choose the quality of Session’s sample rate conversion. There are five
possible settings ranging from “low” to “high.” The setting that you choose will affect the quality of
sample rate conversion that occurs both during bouncingand when importing sound files not
originally recorded at your session’s current sample rate. The higher the quality of sample rate
conversion that you choose, the longer Session will take to perform the conversion. Be aware
that even the “low” setting provides results that are considerably better than the Mac’s built-in
sample rate conversion. For most applications, the “medium” setting will yield very good re-
sults. Because the “high” setting takes significantly longer than other settings, we recommend
that you use it only in cases where the highest fidelity is absolutely essential and you have a
considerable amount of time to devote to this process. (The high setting can take as long as
several hours to process a soundfile of moderate length.) Please also be aware that sample rate
conversion is optimized for Power Macintoshes. Non-Power Macs can take an extremely long
time to perform this function, especially at higher quality settings.



Online

This command puts Session on-line so that playback or recording can be triggered by an exter-
nal time code source. In this state, Session waits for a specific SMPTE frame number, and when
it sees that frame number, it will begin audio playback.

Active in Background

This command allows Session to operate in the background with another application. This
allows you to integrate MIDI sequencing program such as Vision, Cubase, or Logic Audio with
Session.

The Setup Menu
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This menu allows you to configure various hardware and software parameters of your Session
system.

Pre/Post-Roll Setup

By selecting the Pre/Post-Roll command and entering a specific amount of Pre- and Post Roll
time, you can adjust playback of a selection to begin before and last until after your selection by
a chosen amount. With this feature you can audition a selection and the data just before and after
it to hear it in context. For reference, 1000 milliseconds equals one second. 500 milliseconds
equals 1/2 second.
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The Pre/Post Roll Setup dialog

OMS MIDI Setup

This dialog allows you to configure several parameters of your OMS MIDI setup in order to use
MIDI devices such as Macintosh MIDI sequencers and external MIDI controllers with your
Session system. In order to use this command, you must already have installed OMS and the
OMS IAC driver in your System. Your Session Installer disks allow you to do this.

Launch OMS Studio Setup

This command launches the OMS Studio Setup application and allows you to configure your
OMS Setup, add MIDI devices, and connect them to your MIDI Interface so that they will be
available in Session. OMS must be installed in your system in order for this command to be
available.

MIDI Controller Mapping

This dialog allows you to configure parameters for using a MIDI devices to control Session’s on-
screen faders. You will choose a Controller Source and a MIDI Channel over which to send MIDI
messages to Session.

The MIDI Controller Mapping dialog



Time Code Setup

This command allows you to select the SMPTE format appropriate to your project. Session
supports the following frame rates: 24 frame, for film, 25 frame for PAL/SECAM video, 29.97 for
NTSC color video, 29.97 drop for wall-clock accurate broadcast NTSC color video, and 30
frame/30-drop frame formats that are generally used only for time stamping synchronization in
audio-only applications. Make sure that you know without a doubt which of these formats your

project requires before you begin your session. A little extra care up front is always preferable to
hours spent redoing work later.

The Time Code Setup dialog also provides other SMPTE synchronization-related options. These
include the Receive Time Code On parameter which allows you to choose the MIDI port on which
you will receive MIDI Time Code, and SMPTE Offset which allows you to specify a SMPTE
“zero frame” reference for your session. Upon receipt of this frame number, Session will chase
to the correct point and begin playback of digital audio and MIDI.
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The Time Code Setup dialog
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Hardware Setup

The Hardware Setup dialog is used to configure various parameters of Session’s audio recording
and playback hardware. These parameters differ depending on whether you are using a Power
Macintosh or a Digidesign Audiomedia Il card. In the case of a Power Mac, this dialog’s Choose
Power PC Size pop-up menu allows you to choose the number of tracks in your session. (Faster
Power Macs allow up to 16 tracks. Slower Power Macs provide fewer tracks.) In the case of an
Audiomedia Il card, this dialog allows you to choose your sample rate, digital or analog input
format, and other parameters that are available with an Audiomedia Il card.
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The Hardware Setup dialog

Change Playback Hardware

The Change Playback Hardware dialog allows you to reconfigure configure various parameters of
Session’s audio recording and playback hardware during a session. If you are using a Power
Macintosh for example, this dialog allows you to increase or decrease the number of tracks in
your session. If you are using an Audiomedia Il card, this dialog allows you to change other
parameters that are available with an Audiomedia Il card such as sample rate and input format.
If you own both a Power Macintosh and an Audiomedia Il card, this dialog allows you to switch
between using the Audiomedia Il card and using the Power Mac’s built-in recording and play-
back capabilities. You can use this capability to switch to the Audiomedia Il card when record-
ing (for its high-quality inputs) and once you’ve got your instruments on disk, switch to the
Power Mac to work with up to 16 tracks. This arrangement gives you the best of both worlds.
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The Change Playback Hardware dialog

Marker Auto Naming

The Marker Auto Naming dialog allows you to choose several defaults for the names Markers are

given when you are using the Auto Name Markers command. These defaults include a marker

name, a start number, the number of zeros preceding the start number, and a suffix. If the Auto

Name Markers option is enabled (Options menu) Markers dropped “on the fly”” will be named
according to the defaults you have specified here.

Peigaedy Bl Mame Salep

The Marker Auto Naming dialog
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The Display Menu

| Dispioy I

Micro Tracks
« Small Tracks

Medium Tracks

Large Tracks

« Waveforms
Gain Automation
Pan Automation
« Markers
Size Read Out p

SMPTE

Feet and Frames
« Time Line

Bars and Beats

The Display menu contains the commands which determine how Session displays its windows,
tracks, and track data. Here are brief explanations of each command.

Micro Tracks
The Micro Tracks command displays tracks at their smallest size in the Edit window.

Small Tracks
The Small Tracks command displays tracks at reduced size in the Edit window

Medium Tracks
The Medium Tracks command displays tracks at their standard size in the Edit window



Large Tracks
The Large Tracks command displays tracks at their largest size in the Edit window

Waveforms

Enabling this option allows you to view tracks as waveforms (rather than simply as blocks if this
option is disabled) in the Edit window. In order to display a track as a waveform, you must have
already created waveform overview data for it with the Calc All Overviews or Calc Selected Over-
views command.

Gain Automation
Enabling this option allows you to view breakpoint-style gain automation data for tracks in the
Edit window. Gain automation is represented as a red line.

Pan Automation
Enabling this option allows you to view breakpoint-style pan automation data for tracks in the
Edit window. Pan automation is represented as a blue line.

Markers
Enabling this option allows you to view Markers that you have placed in tracks in the Edit
window.

Size Read Out

Enabling this option allows you to select the format in which you want Session to display avail-
able hard disk space and session size. You can choose to display either of these parameters in
either megabytes or track minutes, depending on your preference.

+ Markers
RTINS A . Space Available (MB)

Space Available (Track Minutes)

SMPTE
Feet and Frames | Session Size (MB)

« Time Line Session Size (Track minutes)
Bars and Beats |
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SMPTE
Choosing this command displays the Time Scale in SMPTE frames. SMPTE frame rate is chosen
in the Time Code dialog.

Feet and Frames
Choosing this command displays the Time Scale in feet and frames for referencing audio-for-
film projects. The Feet + Frames time display is based on the 35 millimeter film format.

Time Line
Choosing this command displays the time scale in hours, minutes, and seconds.

Bars and Beats

Choosing this command displays the Time Scale in Bars & Beats. You must use the ldentify Bar &
Beat command to identify at least two reference beats from which Session can interpolate the
Bars & Beats Time Scale.
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The Window Menu

MiH 3EM
Edit #E
Transport 3T
Movie 1r38M

The Windows menu allows you to display any of Session’s four windows: Mix Edit, Transport,
or Movie.



Mix

Choosing this command displays the Mix window. The Mix window provides you with a mix-
ing console-type interface. Here, each of Session’s tracks is represented by a mixer module, each
with its own track gain fader, panning control, solo/mute buttons, and other controls. You will
use this window to record and mix audio.

Edit

Choosing this command displays the Edit window. The Edit window contains all of Session’s
digital editing functions. Here you will see a graphical display of your tracks. Using Session’s
digital editing tools, you can edit and rearrange your tracks nondestructively by dividing them
into pieces or regions and rearranging them in a different order. The Edit window can also be
used to record tracks.

Transport

Choosing this command displays the Transport. The Transport window contains controls for
Play, Stop, Record, Fast Forward, Rewind and Return to Zero. The Transport also contains
controls for creating and recalling Markers which allow you to quickly navigate to a desired
point in a session.

Movie

If you have imported a QuickTime movie into your session, choosing this command displays the
QuickTime movie window. The Movie window can be resized to Half Size, Normal Size, or
Double Size by choosing the desired size command from the Movie menu. You can help maxi-
mize Session performance by displaying the Movie window at Half Size. Displaying QuickTime
movies at larger sizes demands more processing power from your computer.
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The Grid Menu

Enable Grid Mode G

SMPTE Grid »
Feet & Frames Grid »
Time Line Grid b

Bars i Beats Grid P

Grid To Edits

The Grid menu allows you to enable/disable and choose the time format of Session’s Grid
mode.

Enable Grid Mode

Choosing this command turns on Session’s Grid mode. In this mode, regions snap to an invisible
Grid when moved. The reference points on the grid can be SMPTE time units, Feet & Frame
units, Time units, Bars & Beats, or other regions in a session (their start points). This feature
makes it easy to accurately arrange regions in a track according to the chosen grid reference. The
desired grid reference units can be chosen from any of the five choices below.

SMPTE Grid
This command allows you to choose SMPTE time units as Grid points.
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Feet & Frames Grid
This command allows you to choose Feet & Frame units as Grid points.
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Time Line Grid
This command allows you to choose Time units as Grid points.
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Bars & Beats Grid
This command allows you to choose Bar & Beat units as Grid points.
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Grid to Edits

This command allows you to choose other regions in a session (their start or end points) as Grid
points.
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The Movie Menu

Import Movie...

Import Current Movie Rudio
Import O0ther Movie Audio
Mix Audio & Flatten Movie
Set Movie Dffset

Half size 3*0
+ Normal Size 1
Oouble Size #2

Center Movie Window
+ Movie Window Floats

The Movie menu contains all of the commands you’ll use to import QuickTime movies, their
audio, and arrange the size and location of the Movie window on your screen.

Import Movie

This command allows you to import a QuickTime movie into a session. When you select a
movie in the Import Movie dialog, you can view a preview frame using the Show Preview check
box. The preview is always the first frame of the movie. If you have not yet created a preview for
the movie, you can do so by first selecting the movie and then clicking Create in the Import Movie
dialog. After locating the movie you want to import, make sure it is selected (highlighted) and
click Open. Session will display the movie in its own Movie window, and first frame of the
movie will be synchronized to the start time of your session.
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Import Current Movie Audio
This command allows you to import audio from the QuickTime movie currently loaded into a

session. When the Import Current Movie Audio dialog appears, select the desired audio tracks
by clicking them. To select multiple tracks contiguously in this dialog, Shift-click them. To select

them discontiguously, Command-click them. Session will convert the audio tracks to your

session’s sample rate setting and 16-bit resolution, and then import the selected audio track(s)

into the Audio Regions List. The regions are listed in the Audio Regions List with the region
name, the number of the originating track, and the number of the region from the track.

Tragk Impord Window
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Import Other Movie Audio

This command allows you to import audio embedded in a QuickTime movie that is not im-
ported into your session, or from an audio CD. To do so, choose Import Other Movie Audio from the
Movie menu. In the dialog that appears, select the QuickTime movie that you wish to import audio
from. The Track Import dialog that appears displays information about the audio tracks from the
selected movie including the number of the track, number of channels, bit resolution, sample
rate, and enabled/disabled status in the movie. If there is no audio in the selected movie to
import, a dialog will appear to notify you. Select the desired audio tracks by clicking them. To
select multiple tracks contiguously, Shift-click them. To select them discontiguously, Command-
click them. Session will convert the audio tracks to your session’s sample rate setting and 16-bit
resolution, and then import the selected audio track(s) into the Audio Regions List. The regions
are listed in the Audio Regions List with the region name, the number of the originating track,
and the number of the region from the track. From there you can drag the imported regions
from the Audio Regions List into the desired track(s).

Trsrk Impord Window
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Using the Import Other Movie Audio
command to import audio tracks from a QuickTime movie
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Using the Import Other Movie Audio
command to import a track from an audio CD

Mix Audio & Flatten Movie

This command allows you to master your current session to a QuickTime movie. It does this by
bouncing your session (or a selected portion of the session) to a QuickTime audio movie, marry-
ing it to the QuickTime movie currently imported into the session, and writing a new
QuickTime movie to disk. Since this command uses the Bounce Tracks dialog to perform the
bounce, you have the same choices for bit resolution and sample rate conversion as you nor-
mally have with this command. In order to flatten a QuickTime movie, it must start at the begin-
ning of the session. If the Movie Offset (Set Movie Offset command) is set to a location other than
the start time of the session, the Mix Audio & Flatten Movie function will NOT be available. If you
want to compile a new movie with a Movie Offset, use the regular Bounce Tracks command from
the File menu to output your session audio, and then marry the bounced audio with the video
material in movie editing software such as Adobe Premiere and create the offset there.

Set Movie Offset

This command allows you to specify a time duration (in SMPTE frames) that will elapse before
QuickTime movie playback begins. This provides you with a convenient means of starting audio
playback before movie playback.
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Half Size
Choosing this command displays the movie at half of its normal size.

Normal Size
Choosing this command displays the movie window at its standard size.

Double Size
Choosing this command displays the movie window at twice is normal size.

Center Movie Playback
Choosing this command centers the Movie window in the middle of your screen.

Movie Window Floats
Choosing this command makes the movie window “float” on top of all other windows so that it
cannot be obscured.



